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2. Solving partial differential equations (PDEs) 
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Hyperbolic PDEs 
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2.2 Finite difference method  
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Convergence, consistency, well-posedness, stability 
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2.3 Basic difference schemes for advection equation  
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Implicit scheme for heat equation 
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Summary of schemes for parabolic/heat equation 

 

2.8 Advection diffusion equation 
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2.10 Difference schemes for conservation laws 
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2.11 Riemann problem for Burgers equation 
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Other numerical methods: 

• Finite volume methods - 2D and 3D 

• Finite element methods (FEM) 
-Galerkin method 
-Rayleigh-Ritz method 
-weighted residual method 
-discontinous Galerkin (DG) method 
-spectral methods - Fourier series 

 
Conclusion: 

-finite difference method-hyperbolic and parabolic evolution equations conservation 
laws - hyperbolic non-linear PDEs  

-computer laboratory session tomorrow 
-lecture and computer laboratory session ”Fluid simulations of laser-produced 

plasmas" by Milan Kucharik-Euler equations-system of conservation laws for compressible 
fluid dynamics 
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4. Numerical simulations for laser-produced plasmas 

4.1 Introduction to simulations 

Numerical simulation is an important tool in scientific research. It is often confused with the 

theory. However, it is a way of reality exploration additional to experiment and theory (see 

Fig.11.1). Sometimes, it can be difficult to extract the exact reason for particular effect from 

numerical simulations. And it is often difficult to find the dependence of results on experimental 

parameters. So analytical theory is important, even when it has to be simplified and even if 

analytical solution cannot be obtained.  

There are several reasons why computer simulations are carried out. First, they can help 

scientists to understand consequences of the fundamental physics laws. Thus, conditions 

interesting either for basic science or for applications can be selected for a detailed 

exploration.  

Second, computer simulations help in interpretation of experimental results. Often, 

experimental information is incomplete as measurement of some important quantities is too 

difficult or virtually impossible. For instance, interaction of femtosecond laser pulses with 

targets is an important field of study but not many information can be obtained with 

femtosecond resolution. Fastest X ray streak cameras have time resolution of approximately 

half-picosecond. However, the emitted signal is often too weak for reaching picosecond or 

even nanosecond temporal resolution, and thus only time integrated X-ray spectra are 

available in some experiments. Another example is the laser-induced particle acceleration. 

The properties of laser-accelerated particle beams can be accurately measured, however, the 

details of acceleration process are very difficult or practically impossible to detect. Thus, 

computer simulations are carried out and if the resulting beam properties match well with the 

experiment, the researchers believe that the simulations describe the acceleration process 

with reasonable accuracy.  

Third, computer simulations help to design new experiments and predict their results. 

Experiments are often expensive and the space of experimental parameters is often too broad 

for random scanning. Thus, preliminary choice of experimental parameters is must. Results 

of numerical simulation also help in the selection of suitable diagnostics. The expected signal 

may be too weak for particular diagnostics to be detected. Or the signal may be too strong 

leading to the diagnostics saturation or it can even cause damage in the diagnostics 

equipment.  

Numerical simulation consists of writing a computer code and using a computer for 

performing numerical experiment which shows evolution of some nonlinear system. Analytical 

solutions exist for most of linear problems, so numerical simulations are usually not necessary. 
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However, linear problems may serve for a partial validation of numerical codes. Most of 

problems in laser plasma interactions are highly nonlinear, so numerical simulations are 

inevitable for their solution, and for design and interpretation of experiments. Both the z-pinch 

and laser produced plasmas are magnetised. The z-pinch because of the current which flows 

in it and generates an azimuthal magnetic field and the laser produced plasmas due to 

currents generated in the blow off plasma. Waves propagating in a magnetised plasma are 

important because they determine the plasma characteristics and can also be used as 

diagnostic purposes. In order to understand the propagation of an electromagnetic wave in a 

magnetised plasma we start from Maxwell's equations: 

 

 

Figure 4.1 Ways of reality explorations – schematics (courtesy C. Ren, presentation [1] at 

2009 HEDP Summer School) 

4.2 Plasma description and types of numerical simulations 

Plasma dynamics is usually described via kinetic or fluid models. Kinetic description is based 

on an equation for particle distribution function ( , , )f r p t that is solved either directly or 

indirectly. Kinetic description is usually used for weakly coupled plasma and it cannot be 

applied for non-evaporated part of dense (solid or liquid) targets. The advantage of kinetic 

description is a possibility to treat highly non-linear phenomena in laser-plasma interactions 

where important differences from Maxwellian distribution occur. However, kinetic description 

is computationally very demanding. Direct solving a kinetic equation (either collisionless 

Vlasov equation or collisional Boltzmann or Fokker-Planck equation) generally means solving 

partial differential equation in 7 variables, which is often above capabilities of present 
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supercomputers. One reason of inefficiency of this approach is the necessity of solving the 

kinetic equation in the parts of configuration space where particles occur with very low 

probability (unoccupied phase space). This can be improved by sampling the configuration 

space with particles or macroparticles. Then, equations of motion in self-consistent 

electromagnetic fields are solved for each (macro)particle. Easy parallelization is an important 

advantage of this approach, and thus even 3D problems may be solved using big 

supercomputers. Sampling of the distribution function by finite particle number inevitably leads 

to a certain noise that must be kept in acceptable limits. Particle simulations are the main 

approach for simulations of interactions of intense ultrashort laser pulses with targets while for 

longer laser pulses they are usually used in limited spatial and temporal intervals for detailed 

studies of specific nonlinear effects. 

 

Figure 4.2 Configuration space with computational grid and occupied space [1] 

Fluid approach describes plasma via first few moments of the distribution function. Usually, 

zeroth, first and second moments are used describing particle density, momentum and 

energy, so the fluid equations describe conservation of particle number, momentum and 

energy. The fluid description is incomplete as the details of distribution function are not taken 

into account. Consequently, some effects may be missing (as e.g. Landau damping) or may 

be described incorrectly. Fluid equations may be formulated separately for electron and ion 

fluid but this is rarely used in numerical simulations as it includes fast effects and thus it 

requires time step comparable with one over plasma frequency p. Fluid approach is usually 

used for simulations of large scale low frequency plasma processes where quasi-neutrality 

condition is met and thus, plasma may be described in one-fluid approximation. As the energy 



 
 

P a g e  | 60 
 

equilibration between electrons and ions (electron-ion relaxation) is slow compared to the 

momentum transfer, two temperature approximation is applied. If magnetic fields are 

important, magneto¬hydrodynamics (MHD) is employed. However, most MHD codes used in 

astrophysics cannot be applied directly as they omit magnetic field generating terms (like 

Biermann battery term due to crossed density and temperature gradients) important for laser-

produced plasmas. As most of interaction experiments are carried without external magnetic 

field and quasi-static magnetic field generated during the interaction reaches the maximum 

value only after the laser pulse, it may be often omitted and ordinary hydrodynamics may be 

used. When high atomic number (high Z) materials are involved, radiative transfer must be 

solved together with hydrodynamics and such approach is called radiation hydrodynamics. 

Possibility to include cold dense (solid or liquid) material into fluid description is its important 

advantage and thus global simulations of nanosecond laser-target interactions are conducted 

via fluid approach. Fluid codes are also used for calculations of initial density profile for kinetic 

simulations of high intensity femtosecond interactions as the target is usually affected before 

the arrival of the main pulse due to insufficient contrast of the intense ultrashort laser pulse. 

Lower computational demands of fluid approach allow modelling of greater temporal intervals 

and spatial regions than in the kinetic approach. On the other hand, treatment of many non-

linear processes can be included only phenomenologically, based on coefficients taken from 

theory or from kinetic simulations. In the fluid approach, suitable choice of equation of state 

(EoS) that links plasma pressure and internal energy to temperature and density is important. 

The mean ion charge must be calculated either via EoS or separately. Detailed atomic model 

may be included in the fluid code or it may be used as a post-processor. 

Certain data for simulation of plasma dynamics may be prepared by pre-processor codes. 

The results of codes calculating plasma dynamics may be post-processed in order to carry 

out direct comparison with experimental diagnostics or to assess possibility to use laser-

produced plasmas as a radiation or particle source for applications.  

Detailed atomic physics of plasmas are usually modelled by specialized codes. The task 

may be split into 2 parts. First, excitation levels and transition rates of ions are calculated by 

solving the equations of quantum mechanics (e.g. Hartee-Fock equation with configuration 

interaction and relativistic corrections). This is very difficult task for ions of heavy elements 

with many bound electrons and if possible it is corrected with the help of experimental data for 

the spectral line energies. In the second part, collision-radiative (CR) model is solved to find 

the populations of the energy states and the emission (or absorption) spectra. The model can 

be stationary for particular plasma parameters or time-dependent. Plasma may be assumed 

either optically thin or radiative transfer must be included in a certain approximation (e.g. 

escape factors). 
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4.3. Kinetic methods 

Methods describing plasma through distribution function may be divided into 2 basic types – 

particle methods that sample the distribution function and methods that directly solve a partial 

differential equation for the distribution function. Particle methods are easier to code up and 

analyse, they are more robust and economical, but they are noisier. There are implemented 

also in 3D where direct solvers of kinetic equations are impractical. Direct solvers of kinetic 

equation are sometimes preferred when the studied effect is caused by a small group of 

particles (e.g. particles at high energy end of the distribution). 

4.3.1. Particle methods 

Particle simulation techniques attempt to model many-body systems by solving the equations 

of motion of a set of particles. Tracking particle trajectories enables us to explore physical 

effects which are inaccessible to other modelling techniques. The method employs the 

fundamental equations without much approximation, allowing it to retain most of the physics. 

The algorithm consists of (1) loading of the initial particle positions and velocities, (2) 

calculating the force on each particle and (3) solving the equation of motion for each particle. 

 

Figure 4.3 Electron distribution 50 fs after laser interaction with 4 m wire calculated via 

parallel 3D tree code PEPC.(P. Gibbon). 

The simplest approach is the particle-particle method. It treats binary interaction between all 

particle pairs. The basic limitation is the number of arithmetic operations required in the 

calculation of forces as it scales as N2 where N is the number of particles. Thus, this approach 
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is viable only for a small number of particles N < 106 [1]. Thus, only some microscopic 

processes may be modelled by this approach.  

One clearly needs to reduce the scaling of the operation count below N2. There are two 

approaches how to decrease the operation count (1) particle-cluster method, so called tree 

code and (2) particle-mesh method, so called particle-in-cell code. The second method is 

faster and more popular while tree codes are slightly slower but less noisy. 

 

Tree codes [2] 

Tree codes treat near interactions in the same way as particle-particle codes. However, the 

distant particles are grouped and the potential of a group of distant particles is approximated 

by a low-order multipole expansion. Operation count in the force evaluation is below N×log(N). 

Tree codes need more CPU time than particle-mesh codes, but they are favoured in systems 

with large density contrast. They also do better jobs in resolving small scale features of the 

solution and they are less noisy than the particle-mesh methods. However, most of existing 

tree codes are electrostatic as it is more difficult to treat laser field in a tree code. Nevertheless, 

3D parallel electromagnetic tree code PEPC has been developed by Paul Gibbon and it is 

capable to perform realistic simulation of ultrashort pulse with mass-limited target as shown in 

Fig. 11.3. 

 

Particle in-cell codes [3] 

In particle-in-cell (PIC) codes, numerical mesh is added in order to compute the forces 

acting on the model particles. The basic cycle of PIC code consists of 4 steps depicted in 

Fig.11.4. (1) The particle positions are interpolated to the grid points where charges and 

currents are computed. (2) Maxwell’s equations are solved on the computational grid and (3) 

the fields are then interpolated to the particle positions to compute forces acting on particles. 

(4) particle equations of motion are solved to get particle positions and velocities in the new 

time step.  

The particle push must be usually supplemented with boundary conditions for particles. 

Particle collisions may be added after particle push; one option is to select colliding particles 

from particles within one cell randomly via a Monte Carlo algorithm [4] and vary their 

momentum according to the collision differential cross-section. Optical field ionization can be 

also added as well as other atomic processes. However, the addition of collisions leads to a 

very significant increase in the computational time. Thus, collisionless PIC simulations are 

preferred unless the impact of collisions is very significant. 
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Figure 4.4 Schematics of basic cycle of a PIC code. 

 

The number of floating point operations in PIC codes scales as lng g gN N N N  + + , 

where Ng is the number of grid points and , ,  are constants. If the number N of particles is 

significantly larger than Ng, then most computations are needed for particle push that is easy 

to parallelize efficiently. As an example, 10000 time steps in simulation with 108 particles in 

64×64×64 cells can be carried out in 3 seconds on 10 Tflop/s computer [1]. 

PIC method is basically designated for modelling of systems, where close neighbors 

contribute little to the force on a particle which is dominated by the sum of its interactions with 

distant particles, i.e. collective interactions dominate over binary interactions. Such systems 

are called weakly correlated or weakly collisional and ideal plasma is a typical representative 

of these systems. Basic PIC model treats these systems in collisionless approximation, while 

the impact of binary collisions may be taken into account via additional algorithm. PIC method 

cannot be used in strongly correlated systems like for instance solids. In plasmas, binary 

interactions are effective only for distances less than Debye length while at larger distances 

collective interactions dominate. In the PIC method, macroparticles represent a cloud of 

particles occupying a small area in the configuration space. Spatial dimension of macroparticle 

is assumed equal to the grid cell. When the grid cell dimensions are taken equal to the Debye 

length, binary interactions are effectively omitted in the PIC model. 

PIC method may be performed in 1, 2 and 3 dimensions, where the macroparticles have 

shape of slabs, rods and cubes, respectively. Additional velocity components may be taken 

into account leading to currents in the directions normal to the spatial ones. Thus, 1D2V, 1D3V 

and 2D3V simulations are also used. While a standard PC is sufficient for typical 1D 

simulations, powerful workstations or small clusters are typically used for 2D simulations. 3D 

simulations need massively parallel computing and they generate extensive data sets that are 

laborious for processing, visualization and interpretation.  

Equations of particle motions have to be solved by a fast, reasonably accurate and stable 

method. The leap-frog method is very popular. In this method, positions and forces are 
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The error caused by the substitution of the derivatives by the differences is called 

truncation error. For the leap-frog method, the truncation error is proportional to t2, so the 

method is of the second order of accuracy. Leap-frog is an explicit method for which the 

maximum time step is limited by the requirement of stability which means that the total error 

must not grow in time. The fastest mode limiting the time step is the plasma oscillation when 

electrons are oscillating with frequency p in respect to ions due to the electrostatic force 

restoring neutrality. The force acting on electron is 2/i i p iF m x= − . When restoring force is 

inserted into (1) and the electron coordinate and velocity in time instant nt are proportional 

to exp(int), the eigenfrequency  of difference equations is given by the following dispersion 

equation 

2

2sin
2 2

p tt    
=   

   
. 

 

Thus for t > 2/p, the solution for  is not real and consequently, the amplitude of plasma 

oscillations in the numerical scheme grows in time. For shorter time steps t < 2/p, the leap-

frog method is stable and the difference between  and p leads to a phase error that 

decreases with decreasing time step t. Implicit schemes allow longer time steps, but the 

computation of the quantities at the next temporal instant is more time consuming and coding 

is more difficult especially for laser plasma interactions. Thus, most popular codes presently 

use explicit algorithms. 

The deviation of conservation laws caused by the truncation error should be minimized. 

As the algorithms usually cannot be made fully conservative, unphysical growth of 

temperature, known as numerical heating, must be kept at negligible values during the whole 

simulation run. 

After the particle push, charge and current must be assigned to a grid point. Once we 

introduce the grid, we can no longer view the particles as point particles, this leads naturally 

to the idea of a finite sized particle. Then, instead of charge assignment to the nearest grid 

point, it is natural to treat macroparticle as a cloud of particles and split the charge to the near 

grid points (cloud-in-cell). More elaborate smoother charge distributions may be used to 
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suppress the noise. However, such schemes may become complicated and inefficient in more 

dimensions, and especially in 3D. 

 

Figure 4.5 2D3V simulation of electron acceleration (optical injection by orthogonally 

crossing laser pulses) [5]. Electric field plotted in grey, main laser pulse is at x  25 μm. 

Maxwell’s equations are usually solved by a finite difference time domain (FTDT) method. 

In electromagnetic codes, the equations for curls of electric and magnetic field are directly 

solved. Though the equations for divergences are automatically fulfilled in the differential 

equations, there has to be an extra care to meet this condition in their differential analogue. 

Boundary conditions may be either periodic or reflecting or open. Additional perfectly matched 

layer is used to eliminate the reflection of outgoing electromagnetic waves. 

 

 
Figure 4.6 2D3V 3D simulation of interaction of circularly polarized laser of a0=30 and 

duration 12 period T0 incident from left on solid plastic foil 0.08 λ0 thick. Ion density at 35 T0 [6]. 
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An example of PIC simulation results in Fig.11.5 shows one advantage of particle 

simulations – the possibility of particle tracking. Electrons denoted by the blue color were 

injected by the crossing laser beam; electrons pre-accelerated by drive beam are red and 

electrons induced by self- injection are black. The particle positions are overlaid on grey 

electric field, main drive laser pulse propagating to the right is at the right side of the figure 

and laser wake field propagates behind it. In Fig. 11.6, a result of 3D simulation of ion 

acceleration by an intense ultrashort circularly polarized laser pulde is presented. The density 

distributions of protons (cyan), carbon ions (blue), and oxygen ions (purple) are plotted after 

the interaction at t = 35 T0. The circles show the proton bunch and carbon ion bunch, 

respectively. 

4.3.2 Solving kinetic equations 

Vlasov equation 

Vlasov simulations solve similar problems as PIC codes. However, they are computationally 

more demanding. Most often 1D simulations are carried out, though 2D simulations are also 

performed at present. One advantage is the absence of noise. Vlasov simulations are 

preferred when a small number of particles at the distribution tail is essential. Vlasov 

simulations may distinguish small scale structures in the configuration space. The solution of 

Vlasov equation evolves to the formation of very small structures that are dispersed in plasma 

even by a small number of collisions. Thus, a small number of artificial or physical collisions 

is usually introduced to suppress this behavior. As an example, the electron phase space of 

relativistic KEEN wave obtained in Vlasov simulations of stimulated Raman scattering is 

plotted in Fig. 11.7.  

 

Figure 4.7 Electron phase space of relativistic KEEN wave in Vlasov simulations [7]. 
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Collisional kinetic simulations 

Kinetic equation with collisions is solved for the investigation of processes where collisions are 

essential and the deviations of particle distribution from Maxwellian distribution are significant. 

Typical studied effects are the electron non-local heat transport between critical and ablation 

surface, collisional (inverse bremsstrahlung) laser absorption and its impact on the electron 

distribution and also the impact of collisional atomic processes. Overdense plasma between 

critical and ablation surface is usually highly collisional and thus, PIC simulation are not 

efficient there.  

Various collisional terms may be used, the most popular is the Fokker-Planck term, which is 

simpler than Boltzmann and Lenard-Balescu terms that are also sometimes used. Self-

generated electric field may be calculated from the Poisson equation (Vlasov-Fokker-Planck 

code) or it may be obtained from the condition of quasi-neutrality. 

The distribution function may be expressed via a series of spherical harmonics that are 

eigenfunctions of the collision operator, as follows 
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where µ=vx/v. In the simplest case only 2 terms are retained. 

 

4.4 Fluid simulations 

Often, one does not need the detailed knowledge of the particle distribution functions. The 

description is simplified in the fluid (also called hydrodynamic) models where the moments of 

the distribution functions are used. Fluid description is more accurate in dense plasmas where 

the collisions decrease deviations from the Maxwellian distribution. The basic moments are 

the density (0th moment), the average velocity (1st moment) and the internal kinetic energy (2nd 

moment) that are defined, as follows 
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In the fluid description, one typically solves a system of conservation laws for the particle 

number, momentum and energy. These laws are partial differential equations (PDEs) in space 
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and time, but not in velocity. Thus, fluid approach is less computationally demanding than the 

kinetic description and it can be also used for strongly coupled systems. Consequently, it is 

applied for global simulations of laser interactions with dense (solid, liquid) targets. On the 

other hand, non-linear processes in laser-target interactions can be treated only in a 

phenomenological way, many processes have to be included using either analytical models 

or an experience from the kinetic simulations. 

Fluid models are usually used for simulations of processes slow compared to plasma 

frequency p. In principle, two fluid (electron and ion) models can describe also fast processes, 

however, they cannot be used for dense systems and they omit some aspects of particle-wave 

interactions (e.g. Landau damping), so PIC simulations are more appropriate for these 

processes. For processes slow compared to p quasi-neutrality may be assumed and one-

fluid approximation is sufficient. When a quasi-static magnetic field is important, 

magnetohydrodynamics (MHD) must be used. In MHD description of laser-target interactions, 

source terms like source due to crossed gradients of density and temperature (Biermann 

battery term) have to be retained though they are omitted in most typical astrophysical codes. 

In most situations, the impact of quasi-static magnetic field is small during the time when laser 

is interacting with the target and thus, ordinary hydrodynamics is used. As the energy 

equilibration between electrons and ions is slow due to ratio of ion to electron mass, separate 

equations are often used for electron and ion temperature. For high-Z targets, a significant 

part of energy is contained in radiation, and thus, radiation hydrodynamics is used. 

Fluid dynamics is described by a system of conservation laws represented by equations 

of hyperbolic type. It is surprisingly difficult to develop suitable difference scheme for hyper-

bolic PDEs. For enlightening this problem, we shall use the simplest hyperbolic equation, the 

advection equation 
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The solution is analytical 0( , ) ( )u t x u x a t= − . The advection equation is ideal for testing of 

numerical methods as it is simple (linear) with the known analytic solution. From various 

combinations of finite differences, the natural scheme is the FTCS (forward time central space) 
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The basic requirement for a difference scheme is its stability, the total error should not grow 

in time. Stability may depend on the Courant-Friedrichs-Levy number CFL = at/x. 

Unfortunately, FTCS scheme for advection equation is unstable for any CFL number. Instead, 

it is possible to use 1st order accurate Lax-Friedrichs scheme or 2nd order accurate Lax-

Wendroff scheme that are stable for -1 CFL  1 
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The solution of propagation with a = 1 of initial Gaussian pulse of height 1 and width 5 by the 

above methods is presented in Fig. 11.8. Unstable FTCS method is unusable, while the stable 

methods track the pulse motion correctly. Lax-Friedrichs scheme is diffusive, the pulse is 

broadened and lowered. On the other hand, the dispersive Lax-Wendroff scheme leads to an 

oscillatory pulse shape. The calculated pulse shape can be partially improved by a suitable 

alternation of these two methods during successive time steps. The time step may be 

increased by using implicit schemes, for example FTCS with spatial derivative taken in n+1 

time instant is stable for any CFL number. However, no explicit formula exists for the next step 

values and non-linear equation system has to solved in each time step. 

 

 

Figure 4.8 Advection equation (a) Initial pulse. Solution at T=160 via (b) FTCS scheme (c) 

Lax-Friedrichs scheme and (d) Lax-Wendroff scheme. 

In the simplest case, the fluid equations are the Euler equations for the conservation of mass, 

momentum and energy 
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where symbol  denotes tensor multiplication,  is the density, w  is the velocity vector, E is 

the total energy density and p is the pressure given by the equation of state p = p(,), where 

the specific internal energy 
2

/ / 2w = −E .  

When a computational mesh fixed in space is chosen for solving fluid equations, one 

speaks about the Eulerian frame. Fluid moves through the static computational frame in the 

form of fluxes. Methods for solving fluid equations in the Eulerian frame are well understood 

(Lax-Friedrichs and Lax-Wendroff schemes are typical Eulerian methods) and easy to 

implement. The theory of their stability and properties is well advanced. However, the fixed 

computational mesh is not suitable for tasks with enormous expansions (or compressions) of 

the computational domain, which is typical for laser interactions with solid targets. Also, 

tracking plasma-vacuum boundary is a problem in the Eulerian frame and a low-density 

ambient plasma is usually used instead of vacuum.  

Alternatively, the Lagrangian 

frame may be used where the 

coordinates are attached to the 

moving fluid. The positions of the 

nodes move together with the fluid, 

so there is no mass flux between the 

adjacent cells and the mass of a cell 

is constant in time. Time derivative in 

the Lagrangian frame is the total 

derivative d/ d /t t w=   +  . Vis-

cosity has to be added in case of a 

cell compression (typically due to an 

incident shock wave). The disadvan-

tage of Lagrangian approach is the possibility of deformations of computational cells, e.g. due 

to shear. This leads to amplification of the numerical errors and eventually, the simulation may 

fail when non-convex or negative volume cells appear. A typical result of a Lagrangian 

Figure 4.9 Density and temperature profiles 0.3 ns 

after maximum of 0.4 ns FWHM laser pulse of  = 

439 nm and energy 58 J incident from the top on 5 

m-thick Al foil [8]. 



 
 

P a g e  | 71 
 

simulation is presented in Fig. 11.9. Laser is incident from the above normally on 5 m-thick 

Al foil positioned at y=0, laser spot radius is 50 m. Laser-induced plasma corona expands up 

to ~700 m, so the simulation area is increased more than 100× in y direction. The critical 

density cr ~ 0.02 g/cm3 is more than 100 times lower than the density of solid Al and in 

Lagrangian approach it is easy to choose cell dimensions that ensure a sufficient resolution in 

the important area of critical surface neighbourhood. 

 

  

Figure 4.10 (left panel) Computational grid and target temperature in eV 80 ns after the 

impact of laser accelerated disk on bulk target. (right panel) Density colormap at the critical 

area (a) initial grid (b) very distorted Lagrangian grid after 0.5 ns including non-convex cells 

and (c) ALE grid still smooth after 80 ns [9]. 

 

The solution for problems of tangling of Lagrangian cells is the Arbitrary Lagrangian-

Eulerian (ALE) method that combines Lagrangian and Eulerian approach. First, several or 

many Lagrangian time steps are computed. After a given number of time steps or when a 

certain deformation of Lagrangian grid is detected, the Eulerian part is started. In this part, 

mesh rezoning untangles and improves the computational mesh. Then, remapping 

conservatively interpolates the conservative quantities from the old to the new mesh. 

Remapping allows mass fluxes between the computational cells. After remapping, the code 

goes back to a sequence of Lagrangian steps. The ALE method combines the advantages of 

Eulerian and Lagrangian approaches. The grid moves together with the fluid, but the Eulerian 

part keeps it smooth. As an example, the result of 2D cylindrical ALE simulation of the impact 

of laser-accelerated thin disk on a bulk target is presented in Fig. 11.10. For purely Lagrangian 

simulation, critical region is at the edge of the impacting disk. The computational grid tangles 

here and the simulation fails as early as 0.5 ns after the disk impact due to the formation of 

non-convex cells. As the simulation aim is to compare the volume of the crater created at the 

bulk surface, the critical region is not very important for the main aim of the simulation. 

However, Lagrangian simulation cannot proceed any more. On the other hand, the ALE 
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simulation overcomes this problem and the computational mesh is kept smooth for the whole 

time 80 ns of the simulation. 

The system of the Euler equations has to be supplemented by additional terms. Laser 

propagation and absorption must be calculated. A variant of ray-tracing model is most 

frequently applied for the laser propagation in an underdense plasma where collisional 

(inverse bremsstrahlung) absorption is taken into account. Laser absorption and reflection in 

the critical surface neighbourhood may be calculated by solving Maxwell’s equations, 

however, this is often substituted by crude phenomenological models that use simplified 

analytical formulas for resonance absorption. As energy absorbed due to resonance 

absorption and due to nonlinear parametric instabilities goes basically into a relatively small 

group of fast electrons that transport energy far from the absorption region, simplified model 

of energy transport by fast electrons is included in some fluid codes. Electron heat conduction 

from the critical to the ablation surface is mostly non-local due to large temperature gradients. 

The classical heat flux proportional to minus gradient of electron temperature has been 

traditionally restricted by the free streaming heat flux with arbitrary coefficient f called flux 

limiter (usually set in range 0.05 – 0.1). Classical Spitzer-Harm thermal conductivity is valid 

for ideal plasmas, but it severely underestimates heat conductivity at low temperatures, thus 

an ad hoc interpolation between low and high temperatures is usually used [10]. Recently, 

heat flux is calculated non-locally using convolution or multi-group approach [11]. Multi-group 

approach [12] is also used for radiative energy transfer, where a separate difficult problem is 

the calculation of radiative opacities [13]. An equation of state (EOS) is needed to connect to 

the pressure and the temperature with the density and the internal energy. Ideal gas EOS is 

most simple but it is not realistic at high densities and low temperatures, thus either some 

simplified analytical models [14] or tabulated equation of state [15] must be used. 

4.5 Summary 

This session has been devoted to an introduction to numerical simulations of laser-target 

interactions. It has been focused mainly to the description of plasma dynamics. There are two 

main approaches – kinetic description via particle distribution function, and fluid description 

via moments of the distribution function. 

Kinetic models are performed either by direct solving of kinetic equation or via sampling 

of the distribution function by macroparticles in particle codes. Particle codes are often 

preferred as they are faster and they may be parallelized efficiently. Particle codes have to 

avoid computationally demanding particle-particle interaction. This is performed either by 

particle-mesh interaction in PIC (particle-in-cell) codes or by particle cluster interaction in tree 

codes. PIC codes are very popular for modelling of interactions of intense ultrashort laser 
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pulses where they are able to model strongly non-linear effects in weakly coupled plasmas. 

3D simulations of interactions are feasible on supercomputers. Macroparticles in PIC codes 

are clouds of particles with dimensions equal to one or a few grid cells. PIC approach 

describes collective interaction of particles through macroscopic electromagnetic fields. 

Microscopic binary interactions may be added if necessary via additional (e.g. Monte Carlo) 

algorithm. PIC approach cannot be used for strongly bound systems where interactions with 

nearby particles dominate. PIC simulations inevitably include certain noise not only due to 

sampling by finite number of macroparticles, but also due to finite grid cells. The noise can be 

reduced by using a tree code, but these codes are rare, slower and more difficult to create.  

Direct solving of the collisionless Vlasov equation is preferred for effects where a few particles 

dominate. However, Vlasov simulations are more computationally demanding and cannot be 

performed in 3D at present supercomputers. Direct solving of collisional kinetic equation is 

preferred for situations in weakly coupled plasmas when the binary collisions play an important 

role and deviations from Maxwellian particle distribution are significant. For instance, such 

codes model accurately the electron heat transport in the highly collisional area between the 

critical surface and the ablation surface of solid targets. 

Fluid codes use simplified description of plasma via density, average velocity and 

temperature. They are well suited for global modelling of laser-target interactions as they can 

also include dense cold (e.g. solid) areas. They usually include processes slow compared to 

the plasma frequency p, and thus quasi-neutrality may be assumed. Consequently, one fluid 

hydrodynamic or magnetohydrodynamic description is used. On the other hand, non-linear 

processes can be treated only phenomenologically. Numerical algorithms for simulations in a 

grid fixed in the space (Eulerian frame) are well developed and understood. However, when 

enormous expansions (or compressions) occur during simulations, Lagrangian frame is 

applied, where the nodes are moving together with the fluid. The problem of the Lagrangian 

approach is possible deformation of computational cells that leads to simulation failure. This 

is cured in Arbitrary Lagrangian-Eulerian (ALE) codes where mesh rezoning and remapping 

of conservative quantities is added to the Lagrangian approach. 

 

 

  



 
 

P a g e  | 74 
 

 

References 

[1] C. Ren, Introduction to Particle-in-Cell Method in Plasma Simulations, The 2009 HEDP 

Summer School, Univ. Rochester, http://hedpschool.lle.rochester.edu/1000_proc2009.php  

[2] S. Pfalzner, P. Gibbon, Many-Body Tree Methods in Physics, Cambridge University 

Press, Cambridge 1997 

[3] C.K. Birdsall, A.B. Langdon, Plasma Physics via Computer Simulation, McGraw-Hill, New 

York 1985 

[4] T. Takizuka, H. Abe, J. Comput. Phys 25 (1977) 205 

[5] V. Horny et al., Phys. Plasmas 24 (2017) 103125 

[6] T. P. Yu et al., Opt. Express 21 (2013) 22558 

[7] A. Ghizzo et al., Phys. Rev. E 74 (2006), 046407 

[8] O. Renner et al., JQSRT 81 (2003), 385 

[9] M. Kucharik et al., Czech. J. Phys. 56 (2006) B522 

[10] K. Eidman et al., Phys. Rev. E 62 (2000) 1202 

[11] G. Schurtz et al., Phys. Plasmas 7 (2000) 4238 

[12] C. Orban et al., A Radiation-Hydrodynamics Code Comparison for Laser-Produced 

Plasmas: FLASH versus HYDRA and the Results of Validation Experiments, Technical 

Report LLNL-JRNL-636375, 2013 

[13] H. A. Scott, JQSRT 71 (2001) 689 

[14] R.M. More, Phys. Fluids 31 (1988) 3059 

[15] S. P. Lyon, J. D. Johnson, SESAME: the Los Alamos National Laboratory equation of 

state database, Technical Report LA-UR-92-3407, LANL, Los Alamos, 1992. 

 

  



 
 

P a g e  | 75 
 

 
 

 

 

PowerLaPs 

 

Innovative Education & Training in High Power Laser Plasmas 

Computational Modeling & Simulations in Laser Matter Interactions  

 

Chapter 5: Numerical modeling and 

simulations Lasers/Plasma 

 

 

V. Dimitriou 

 

 



 
 

P a g e  | 76 
 

5. Numerical modeling and simulations Lasers/Plasma 

Irradiation of solids with pulsed laser beams is a powerful method for materials 

excitation. Due to the great flexibility of the method, the large and monitored power and the 

ability of remote manipulation without any contact with the material, this method is rapidly 

expanding. Common applications of the method include laser surface melting, surface 

reinforcement by laser shock, surface coating and functionalization, physical and chemical 

measurements, assembling and dismantling (surface cleaning), nanopowder production and 

use. Pulsed laser’s irradiation ability of broadband signal generation is also used in industrial 

applications like surface structure detection, compositions, geometry, roughness, plainness 

and elastic properties of metallic specimens’ analysis [1–10]. 

The dynamic reaction of matter irradiated by a nanosecond laser pulse source depends 

on its thermo-physical properties, as well as on the laser pulse characteristics. To understand 

the complex physical phenomenon of this interaction, various analytical and numerical 

approximations have been developed. For most of the numerical approximations the Finite 

Element Method (FEM) is chosen to carry out the simulation of the multiphysics thermal-

structural problem, because of its ability to predict the achievable temperature gradients and 

time-dependent displacements and stresses at multiple locations. FEM is not limited by the 

geometry of the solution domain nor the precision’s variance neither the lack of smoothness 

of solution [11-21]. 

 

 
Figure 5.1 Phase change regimes: (a), (b) thermoelastic, (c) melting and (d) plasma, of pulsed 
laser film-substrate interaction [22].  

 
The main regimes for pulsed laser irradiation of matter are the thermoelastic, melting 

and ablation (plasma) regime. In the thermoelastic regime, the area of the sample irradiated 

by the nanosecond laser pulse is rapidly heated by the absorption of the laser energy. The 

heating rate and the surface temperature are defined by absorption and reflection coefficients, 

by thermal conductivity, and by the specific heat of the metal. The sole form of heat transport 

is conduction within the metal (Fig. 9.1). The absorption of energy results in a rapid increase 

of temperature in the irradiated volume, which in turn causes a local rapid thermal expansion. 

The localized thermal expansion generates a stress field and ultrasonic surface acoustic 
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waves (SAWs) that propagate in the target’s material. SAWs provide valuable elastic 

information in the vicinity of surface over which the waves propagate, because the surface 

wave phase velocity is directly dependent on the elastic tensor of the material [23]. Acoustic 

surface waves are well suited for testing thin films, which are used extensively with applications 

covering various sectors of industrial activity [24,25]. For greater laser intensities the target 

surface temperature reaches its melting point (Fig. 1(c)). At this stage, the melted front 

penetrates the solid phase, while the thermal and optical properties of the target material 

change. For even greater laser intensities the target surface reaches its boiling point. The 

process of material removal from the target is called laser ablation. For incident laser 

intensities greater than the ablation threshold plasma is formed (see Fig. 1(d)) [16,26]. Laser 

plasma is composed of a large amount of electrons, ions and excited neutrals that absorb the 

laser light. For all regimes, the generation and propagation of SAWs depends on both the film 

and substrate thermo-physical (elastic) properties, as well as on the laser pulse characteristics. 

Studies by the help of FEM have been carried out on the behavior of thin films surface under 

nanosecond laser pulse excitation [16-21]. Xu et al. [17,18] studied the transient temperature 

and temperature gradient fields in coating-substrate systems as well as the surface normalized 

vertical displacements at different source-receiver distances and to the epicenter. Their work 

is focused on the thermoelastic regime. In [19] the laser ablation of titanium carbide with the 

aid of a two dimensional (2D) finite element model is simulated, based on the heat conduction 

equation and on the Hertz-Knudsen equation of vaporization. In [16] a 2D finite element model 

capable to predict temperature distribution and ablation depth by taking into account the 

absorption of laser radiation in plasma is developed. The work presented in Ref.’s [16] and 

[19] is focused on the pulsed laser ablation phenomenon and the ablation depth (crater’s 

formation). 
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5.1 What is FEM? 

5.1.1 A typical problem description 

FEM is a numerical method originally developed as: a branch of Solid Mechanics. Nowadays 

FEM is a commonly used method for MULTIPHYSICS problems. The physical problems that 

science aims to solve may be categorized to: Structure analysis problems: a cantilever, a 

building, a bridge, etc.; Solid mechanics problems: a gear, an air wing, etc.; Dynamics: 

vibration of a bar, of a tower, an earthquake, etc.; Thermal analysis problems: heat conduction, 

radiation of a surface, etc.; Electrical analysis problems: electrical signal propagation, 

piezoelectric actuators, etc.; Biomechanics: human organs, bones, tissues, etc.; Fluid 

mechanics, Magnetic analysis... are some of the basic fields that numerical simulations may 

work for. The Multiphysics problems may include some or ALL of these branches of problems 

that may be mathematically described by the help of Differential Equations. 

To explain the mathematical modeling philosophy of the FEM let’s assume a solid with 

known Properties: materials & geometry as presented in Fig. 2 having known:  

• Boundary: (2D)-The blue line, (3D)-The blue surface that is enclosing the geometry 

• Solid: Interior: Surface (2D) or Volume (3D) 

• Boundary conditions: Prescribed quantities (e.g. prescribed displacements, prescribed 

displacements, velocities, stresses, strains etc.) 

• Loading conditions: Force, pressure, thermal, electro, magnetic loads 

 

 

Figure 5.2 A solid imposed to an axial force. 

 

The questions that has to be answered is: What will happen to a solid if a Force is applied to 

it? and Which will be the values of Displacements, Stresses, Strains? ... at each material point 

of the solid body [27, 28].  
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Figure 5.3 Deformed solid. 
 

5.1.2 Mathematical formulation 

For the mathematical formulation of the typical problem described in 9.2.1, the Equilibrium the 

Constitutive and the Strains (Kinematics) equations may be used: 

 

 

 

The determination of the values of the unknown variables: Displacements: u1, u2, u3; Stresses: 

σ11, σ22, σ33, σ12, σ21, σ23; Strains: ε11, ε22, ε33, ε12, ε21, ε23 must be provided by the solution of 

the above 15 equations of which the 9 are Partial Differential Equations (PDE’s). At this point 

we may easily notice that an exact analytical solution is impossible to be found, and this 

consists the main difference of simulations to pure theory. FEM is a numerical simulation 

method that may be used to find the best approximate solution to the problem. Simulations 

are NOT theory. 

Strains (kinematics): 

Constitutive

:

Equilibrium

:
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5.1.3 Basic solid mechanics 

Stress: is an internal quantity that has units of force per unit area. At a point Stress needs a 

magnitude and 2 directions to specify it. The sign of a stress component is determined from 

the direction of the internal force and the direction of the out-ward normal to the imaginary cut 

surface and the shear stress components are symmetric (see Fig.9.4). 

 

 

Figure 5.4 Stresses. 
 

Strain: is a measure of relative movement of two points on the body (deformation). Elongations 

are positive normal strains. Decrease from right angle results in positive shear strains. Small 

strains (ε < 0.01) can be calculated using just the deformation in the original direction of the 

line. Small strain results in a linear theory tensor normal strains equal to engineering normal 

strains and tensor shear strains equal to: (‘engineering shear strains’/ 2), (see Fig. 9.5) 

 

 

Figure 5.5. Strains. 
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For linear elasticity:  

 

 

 

 

5.2 FEM modeling concepts  

 

Figure 5.6. The basic modeling steps of FEM. 
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The basic modeling steps of FEM are presented in Fig 9.6. The solid domain is geometrically 

represented by the help of any CAD system that is further discretized. The finite elements are 

generated by the help of the nodes having known Degrees Of Freedom (DOF’s) and 

interpolation order values. A simple function is used to approximate the displacements in every 

element and a set of linear equations with displacements at each node as unknowns is 

formulated and finally the linear system of equations is solved. The flowchart depicted at Fig. 

9.7 describes these steps. 

 

Figure 5.7 Flowchart of modeling and processing of FEM (pre- & post- processing). 
 

To conclude, we ask FEM to provide results for the unknown values given the minimum 

input data: 

• Geometry: Math description, CAD input files etc. 

• Material properties: Young’s modulus, Density, Poisson’s Ratio 

• Boundary conditions: Supports, Prescribed displacements/stresses etc.  

• The type of analysis: static, transient, modal, thermal, electromagnetic … 

The detailed modeling process includes the selection of the Elements and Mesh for which 

a strategy to create a good mesh by the help of the appropriate Element types is adopted. 

When transient problems are solved, a time function is used to define how the prescribed 

boundary conditions change over time e.g. as ramp, step, sinusoidal etc. In numerical 

modeling time is the physical time counted by a clock, such as in dynamics and transient 

problems OR time simple means that one thing happens before another thing happens, such 
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as in static problems. In summary, the Basic components of a FEM software include six basic 

features: i. Type of analysis, ii. Geometry (defined through mesh nodes), iii. Elements, iv. 

Material properties, v. Boundary conditions and vi. Time functions. 

5.3 Understanding and describing the physical problem 

The aim of a numerical simulation is to describe as approximately as possible the real physical 

problem. Developing a physical model is a process that simplifies a real-world problem into a 

FEM problem. The main considerations in building a physical model is the understanding of 

the nature of real-world problem and the a-priori knowledge of the cost of conducting the 

computational analysis. In many cases the cost of conducting FEM is a major barrier which 

imposes a great challenge and sometimes the maximum accuracy is sacrificed for the 

reduction of the computational cost for the achievement of a good solution. 

The simulation cost demanded for the mathematical processing is strictly affected by the: 

• Number of Nodes: N 

• Degrees Of Freedom (DOF’s / Node) 

• The numbering of the Nodes: Matrix decompositions and algebraic operations costs 

• Number of interpolation and integration points in every finite element: Interpolation 

order costs 

• Nonlinear Analysis: Time integration and singularities 

The type of analysis (static, dynamic, linear or nonlinear, 2D, 3D, transient, …) must be 

decided at the physical model level. The number of nodes and number of integration points 

are chosen during the building of the finite element model level. A good physical model has to 

reduce the number of nodes by one or two orders of magnitude [27,28]. 

 

5.4 FEM model development for the simulation of irradiated materials by 

nanosecond laser pulses 

As depicted in Fig. 9.1, laser energy heats the target surface. The absorption of the laser pulse 

results to an increased localized temperature. The heating rate and the surface temperature 

are defined by absorption and reflection coefficients, by thermal conductivity, and by the 

specific heat of the solid. The target surface temperature reaches its melting point. Thermal 

and optical properties change during melting. In the ablation (plasma) regime, vaporization 

occurs. For incident laser intensities greater than the ablation threshold a large amount of 

electrons, ions and excited neutrals is present in the vaporized material and absorb the laser 

light forming plasma. For even greater laser intensities droplet or solid particle ejections occur. 
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At the very first moments, energy is deposited in the area of the laser beam spot resulting to 

the generation and propagation of Surface Acoustic Waves (SAWs) & bulge formation Bulge 

/Crater and Plasma formation while SAWs are generated and propagate in matter. The 

ultrasonic waves are generated in the solid in all directions from the laser interaction area.  

The FEM model must be capable to simulate: the behavior of matter in every spatial 

direction, for any axisymmetric sample geometries, as well as target samples with no 

symmetry of material distribution. It has to be able to simulate the laser matter interaction 

providing a detailed view of the 3D thermo-mechanical results and giving spatiotemporal 

insights to solid target’s dynamic reactions in any direction and in any regime of interest. The 

bulge formation, the generation and propagation of SAWs and the development of crater must 

be monitored and recorded with high resolution, especially in the cases of melting and ablation 

in order to be compared with the experimental results. Furthermore, the parametric model 

must be able to simulate cracks, enclosures or other defects, symmetric or not, that may exist 

in the sample.  

The developed computational model presented here with a range of simulation results, 

covering every regime of nanosecond pulsed laser irradiation, demonstrating its capabilities. 

Experimental against numerical results obtained by the same model, were originally presented 

in the research work of Dimitriou at al. [22,29,30] and validated its effectiveness and accuracy. 

 

5.4.1 FEM Mathematical modeling 

The governing PDE of the problem is the Thermal conduction equation:  

( , , , )
( ) ( ) [ ( ) , , , )] ( , , , ) i

T x y z t
T C T k T T x y z t Q x y z t L

t



−   ( = −

  

 

(9.1) 

   

Where, T transient temperature function, K thermal conductivity, ρ density, cp specific heat, Q 

heat source, specified as the absorbed energy per volume unit per second and Li latent heat 

(if T<Tm then Li = 0, if T≥Tm then Li = Lm , if T≥Tb then Li = Lv ). 

 

The wave propagation PDE is used to describe the structural part of the problem: 

2
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(9.2) 

Where, U displacement vector of thermal induced elastic waves, λ, μ are the Lamé constants, 

a thermoelastic expansion coefficient. 

 

The model is loaded by the ns Laser heat source spatiotemporally described by: 
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(9.3) 

assumed to be of Gaussian type. Is incident laser power density (laser pulse energy per unit 

area per second), R optical reflectivity of the sample, α optical absorption coefficient (1 /α is 

the optical penetration depth), t0 is the FWHM laser pulse duration, r0 is the FWHM beam 

radius on the sample surface. Attention has to be given to the attenuation of irradiation due to 

the absorption in plasma (consequence of laser irradiation). Thus, increase in the absorption 

as a consequence of plasma heating is characterized by a single parameter, the density of the 

absorbed radiation energy Ea [31]. The temporal laser irradiance may be given by: 

0
( )( ) , ( ) ( ) ( )t

asI t I e t b h t d E t−=  =  +  
 

 

(9.4) 

Where, I0 incident laser pulse energy per unit area per second, Λ(t) optical thickness of the 

ablation plume, h the ablation depth, b and d time independent coefficients to be identified 

(free parameters). 

The classical thermal conduction equation for finite elements with the heat capacity matrix 

[C] and the conductivity matrix [K] can be expressed in terms of vectors based on the finite 

element method: 

      { }
T

K T C Q
t


+


=

 

 

(9.5) 

 

where {Q} is the heat source vector, {T} is the temperature vector and {∂T/∂t} is the temperature 

rate vector. When temperature exceeds the melting point, the latent heat of melting Lm is 

subtracted from {Q}, which becomes 

      { } m
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+ −
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(9.6) 

while Lm is replaced in by Lv when temperature exceeds the boiling point. For wave 

propagation, ignoring damping, the governing finite element equation is: 

     
2

2
{{ } }

U
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t


+


=

 

 

(9.7) 

where [M] is the mass matrix, [S] the stiffness matrix, {U} the displacement vector, {∂2U/∂t2} 

the acceleration vector and {F} the force vector. In general, the external force vector for an 

element is given by:  

      0
T

V

F B D dV=   
(9.8) 
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where {ε0} is the thermal strain vector, [B]T is the transpose of the derivative of the shape 

functions and [D] is the material matrix. 

In this approximation of the 3D transient multiphysics thermal-structural mechanical 

problem, coupled-field analysis may be performed. To avoid individual solutions of the thermal 

and subsequently the structural problem in every timestep, analysis is applied by the 

interaction of thermal with the structural field [32]. Both of the engineering disciplines share 

the same 3D geometry, meshing, appropriate element type, boundary and loading conditions. 

All these Pre-process required input data are loaded for the entire simulation once in the 

beginning. Thus, the computational time is decreased and the possibility of loss of data during 

load transferring is eliminated.  

By the help of the thermal-structural coupling direct method, a single pass solution is 

achieved, involving one analysis that uses the coupled-field 3D solid element type that uses 

eight nodes with up to six degrees of freedom per node. The weak field coupling, used in the 

proposed approximation, is accomplished by the calculation of the appropriate element 

matrices and load vectors resulting by the summation of the element matrices and load 

vectors. The necessary coupling terms may be included to the governing equation results to a 

form where the coupled effects are accounted for load terms F-coupled (Fc) and Q-coupled 

(Qc). This coupling requires at least two iterations in sequence to achieve a coupled response, 

one for each physical model applied [22]: 
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(9.9) 

5.4.2 FEM modeling and simulation results 

To simplify the physical model and reduce the computational cost, the real problem is 

analyzed. A 3D quarter symmetric finite element model is chosen to simulate the laser matter 

interaction with the solid thin film-substrate sample, presented in Fig. 9.6. The model simulates 

a homogeneous, elastic, isotropic metal film-substrate system and its transient thermal-

structural response when a single laser pulse interacts with the metallic film. The 3D FEM 

model is capable to fully describe the dynamic phenomena occurring from the laser energy 

concentration in the metallic film. Golden (Au) metal thin film of 0.6 μm thickness deposited on 

glass BK7 substrate of 200 μm thickness is assumed for the simulations performed. This model 

may ideally simulate the laboratory experiments performed and is validated by the resulting 

experimental data in every regime and under various loading conditions, as originally 

published in Ref. [29], where typical experimental against numerical results were compared. 

 



 
 

P a g e  | 87 
 

 

 

Figure 5.8. 3D quarter symmetric FEM model [22] 

The thickness of the film used is of the order of a fraction of a μm and the heat-affected 

zone is much smaller than the domain of the material, therefore a fine mesh is necessary in 

order to resolve temperature distribution in the film and the irradiated region. As depicted in 

the zoomed detail of the irradiated surface in Fig. 9.8 (top), special treatment is given to the 

mesh of the cyclic area of radius R2 of the laser beam spot. At the limits of this area the 

temperature gradients change rapidly, thus requiring a locally smooth adaptive fine 

discretization [33]. The dynamic thermal effects occurring from the heat conduction are 

responsible for the structural response of matter around this area of high importance. That is 

the reason why a second cyclic area with radius R1 encloses R2 and creates the appropriate 

continuum smooth space, needed for the generation and propagation of SAWs. Since laser-

generated SAWs have high frequencies and transient analysis is performed, a small element 

size is required to deal with these waves. The centre of symmetry is the laser’s epicentre, 

where the maxima gradients of thermal effects occur and the melting and vaporization of 

matter are taking place. To deal with these extreme conditions a 5 μm x 5 μm rectangular 

square area with 12 element divisions in each side is built and mapped normal for 0.6 microns 

(film thickness) with 12 element divisions. This orthogonal fine meshed volume is generated 

to allow precision handling of the dynamic phase changes of matter in the center of the 

irradiated sample. These assumptions result to a sophisticated built locally adaptive fine mesh 

of 20160 elements (22737 nodes) in the quarter cyclic domain of radius R1=85 μm and a total 

of 27360 elements (30732 nodes) in the whole volume of the Au thin film. Likewise, the volume 

of glass is mapped for 3 μm with 12 elements in the normal direction to precisely transfer the 

substrate’s dynamic reactions to the film. The whole sample is discretized to a total number of 

88920 elements (94560 nodes).  
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The FEM model is set in the Global Coordinate System so that the positive Z-axis, follows 

the direction of the laser beam while its Origin (O) is placed to the center of the quarter 

symmetry, as presented in Fig. 9.8. Considering the loading conditions, a heat generation 

function, is applied on the film body. The initial temperature of the body is assumed to be the 

ambient temperature, set equal to 27 0C. Symmetric displacement loads are applied to the YZ 

(ABCO) and XZ (OCDE) planes, while heat flux is set to zero, regarding the quarter symmetry 

of the 3D model. At these planes of symmetry the discretization follows a smooth coarsening 

with increasing the distance from the top surface plane XY (AOEF).  

A total time of 60 ns after excitation and 60 load-steps, resulting to a duration of 1 ns for 

each load-step for the solution, is considered. This time dependent problem is solved 

sequentially, with an incremental timestep of 1 ns. Regarding the laser parameters used in the 

performed simulations, the laser energy ranges from 0.8 to 20 μJ, the FWHM laser pulse 

duration, t0, is 6 ns, while the FWHM beam radius on the sample surface, r0, is 11.5 μm.  

As indicated to the simulation flowchart in Fig. 9.7, all of the described Pre-Processing 

input data are stored and loaded once at the beginning of the simulation process. During the 

simulation the output of the preceding timestep is saved and becomes an input to the 

succeeding timestep. When simulation begins the first transient timestep is submitted for 

analysis. The criterions (flags) used are strictly related to the approximated temperature 

results, as shown in the decision rhombus boxes of the flow chart. At the end of a particular 

step, if the temperature of an element is higher than the melting temperature (Tm), phase 

change occurs, which is taken into account by considering the latent heat of melting (Lm) in 

the model. The ablation is assumed to occur when the temperature of the corresponding 

elements is higher than the boiling temperature. Likewise, in this condition the model takes 

into account the phase change effect by considering the latent heat of vaporization. If the 

resulting temperature of an element overpasses the boiling point, a group of elements (GTv) 

to be vaporized, is created.  These elements belong to the material removal subdomain that 

is realized by the “killing” of the GTv. These elements are deactivated by multiplying their 

stiffness by a severe reduction factor (~1x10-8). When laser fluence is higher than the ablation 

threshold, the optical thickness of the ablation plume, Λ(t), should be considered and Eq. 6 is 

activated and taken into account by the model [16, 19]. Comparison with experimental results, 

strictly demanded for this case, allows for the evaluation of the values of the plasma 

coefficients, a and b, which for our test cases were found to be 1×106 and 1×10-4, respectively 

[29]. For the estimation of a and b values, for any other sample with different material 

properties, this comparison of simulation vs. experimental results, has to be performed. The 

computational time required for each successive time step of 1 ns, is approximately ~30 

minutes and is increased to ~1h when killing of the elements is performed. The simulation is 
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accomplished when the total time of the transient analysis is reached. Representative results 

of the simulation are depicted in Figures 9.9 and 9.10 in accordance to the correspondent 

experimental results and explanation details for the dynamic behavior of the model. 

 

 

 
Figure 5.9 FEM results (a) and comparison to experimental results (b) [34,35]. 

(a) 

(b) 
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Figure 5.10 Comparison of experimental (left) to FEM results (right) [34,35].  

 

5.5 FEM multiphysics simulations for MHD analysis 

To extend our modeling and simulation study to the generation of plasma its features & 

properties, numerical simulations provide computational tools able to describe the dynamic 

behavior of the fourth state of matter. The study of the initiation of the plasma state of matter 

includes the investigation of every phase change step until the initial formation of plasma. To 

secure the final results of a plasma study a validation of parallel effects in every regime by the 

help of comparison of computational predictions versus experimental results is needed. This 

approach requires the development of a method, combining theory, simulations and 

experiments, able to investigate any regime until plasma formation. The deep investigation of 
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the parallel effects to validate the developed theory and models may guide the experiments 

and vice versa. This modeling approach [36-40] of the problem by the help of experimental 

results secures the investigation of plasma dynamics in order to achieve: 

• Clear view of solid matter’s, liquid and gas dynamic response 

• Validated simulation results for every regime 

• Validated initial conditions for the liquid and gas phase 

To understand the initial stages of explosion of dense plasmas as the phase changes from 

solid to plasma take place experiments using a Z-pinch pulsed powered device are performed. 

The experiment is implemented in a mode of producing a peak current of 35 kA with a rise 

time (10%-90%) of 60 ns. The results for the expansion dynamics of the exploded plasma 

obtained from laser probing diagnostics  

• modified Fraunhofer diffraction probe method  

• shadowgraphic techniques 

• interferometric techniques 

• time-integrated optical imaging to monitor matter dynamics. 

A FEM transient multiphysics electro-magnetic-thermal-structural 3D model is developed 

for the numerical study of the problem due to its unique characteristics: 

• versatile and flexible 

• substantial insights into key physical quantities 

• temperature-dependent material properties 

• strength material model (Johnson-Cook) along with an equation of state (Gruneisen) 

The proposed method provides quantitative parameter values: temperature, pressure, 

current density and expansion rate of the exploded material. Offers detailed information of 

temperature gradients, transformations, velocities, etc. for any time step (via FEM model) and 

the expansion rates of the mater and the phase change characteristics of the exploded matter. 

The numerical study of the initial stages of electrical exploding wire that play an important role 

in plasma formation in pulsed-power Z-Pinch experiments. Early time dynamics in the 

explosion of the wire have been proven to be important for the development of Magneto-

Hydrodynamic (MHD) instabilities of the Z-pinch plasma [38,39]. It has been shown that the 

stages of the phase changes from thermoelastic to melting and plasma regimes are crucial 

and that thick metallic copper wires (300 μm) for which electrical charges flow through skin 

depth important role for the exploding dynamics [41,42].  
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5.5.1 3D multiphysics FEM analysis  

A 3D coupled FEM multiphysics simulation based on the method is developed. Maxwell 

equations (eddy-current approximation) are solved using a finite element method (FEM) for 

the wire coupled with a Boundary Element Method (BEM) for the surrounding vacuum. 

Moreover, the skin depth effect for the wire is also taken into account. When the 

electromagnetic fields have been computed, the Lorentz force F=j×B, where j is the current 

density and B the magnetic field, is evaluated at the nodes and added to the mechanical 

solver, which computes the deformation of the wire. Furthermore, the joule heating power term 

j2/σ, σ the electrical conductivity, is added to the thermal solver to update temperature [43].  

In order to properly simulate the magneto-hydrodynamic response of the metal: the 

hydrodynamic behavior is taken into account by using analytical Gruneisen equation of state 

[44], the deviatoric behavior is taken into account using Johnson-Cook [45] strength material 

model and the electrical conductivity versus temperature and density is computed using 

Burgess equation of state [46]. For the mechanical response, the Johnson-Cook model is 

coupled with the Gruneisen equation of state. The Johnson-Cook material model considers 

the effect of plastic strain, strain rate and temperature rise. Temperature dependent properties 

of thermal expansion, thermal conductivity and specific heat, as well as the latent heat of 

melting are also considered. Regarding the boundary conditions, the ends of the wire are fixed 

at environmental temperature (27 0C). An important aspect of the developed simulation is that 

the Lagrangian mesh is appropriately refined to accurately simulate the dynamic phase 

changes of matter in the region of the skin depth. The loading source term is the alternating 

current from the experiments.   

The mathematical modeling of the problem is provided by the Maxwell, the Mass 

conservation, the Momentum and the Energy equations: 
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Figure 9.11 The FEM model (up), Laser probe diffraction pattern and the lineout intensity plot 

along the axis of the fringes at 140 ns from the current start (bottom left). Displacement of the 

x-axis (mm) of the wire the same temporal moment (bottom right) [47]. 

 

At earlier times, the wire, due to the Joule heating, experiences thermal expansion as well 

as melting and vaporization. The model and representative results are depicted in Figures 

9.11 and 9.12. The measurement of the diameter takes place 140 ns from the current start 

and is compared with the initial measurement, presenting an expansion of 7.4 μm and the 

simulation gives an expansion of 7 μm, as shown in Figure 9.11 at the same time.  
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Figure 5.12. Finite element numerical results for temperature (left, 0C) and density (right, 

g/cm3) from a cross section of the wire at 220 ns from current start (up). Interferometric and 

schlieren laser probe images at 220 ns after current start (down left) and numerical results of 

temperature and density distributions computed by FEM (down right) [42,47]. 

 

The computational results demonstrate that the combination of the multiphysics FEM 

model and the experimental method are capable to describe the wire expansion dynamics for 

temperatures below the boiling point. Satisfactory agreement of experimental versus the FEM 

results is also observed concerning the initial times of corona plasma formation.   

Multiphysics numerical simulations of the dynamic response of the target during its 

heating and conversion into plasma have been developed based on the coupling of FEM and 

MHD methods. To study the wire’s response to the heating source (Joule heating), a strength 

material model along with evaluated EOS data are used. The EOS data are necessary to 

describe the hydrodynamic response of the material, while the strength material model 

describes the deviatoric stress behavior or distortion of the material. The density distribution 

and the wire radius at the last time step of the solution provided by the FEM simulation are 
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coupled to a resistive MHD finite difference/volume code (PLUTO). A fluid and a plasma 

region, surrounded by a vacuum region, are considered for the MHD transient analysis. This 

choice is based on experimental results suggesting that the plasma of the Z-pinch target 

consists of a dense fluid that surrounds the solid, which persists for a long time during the 

current discharge, surrounded by a low density hot coronal plasma. The proposed simulation 

method is identical for the study of plasma instabilities, a research topic with fundamental 

importance since for the majority of plasma applications they are unwanted and there is always 

the need for their suppression. The implementation of the FEM-MHD coupled method offered 

a perspective to the understanding of the seeding physical mechanisms in the generation of 

plasma instabilities [41]. Representative MHD results compared to Experimental are 

presented in Figure 9.13. 

 

Figure 5.13 Comparison of MHD simulation with experimental picosecond laser optical 
probing shadowgraphy [41]. 
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8.1 Introduction 

When high-intensity laser pulses interact with matter, they can generate strong shock waves. 

This article is particularly concerned with the case in which a high-intensity laser pulse 

interacts with plasma that is over-dense to the laser. That is to say that the electron gas density 

is sufficiently high, in the media, that the bulk of the material lies beyond the relativistic critical 

surface. The relativistic critical surface is the surface at which the relativistically corrected 

electron plasma frequency is equal to the frequency of the laser radiation. The electron number 

density at which this occurs is given by the equation 

 

                                  Equation 1
 

 

Where 〈𝛾〉= (1 + a0
2/2)1/2 is the relativistic gamma factor introduced by the oscillation of the 

electrons in the electromagnetic field of the laser beam and a0=eA0/mec2 and L are the 

relativistically normalized laser amplitude and the laser frequency respectively.  

At such high densities, the laser beam cannot propagate. Hydrodynamics is driven directly by 

the light pressure, but also at depth within the plasma by the relativistic electron beam that is 

accelerated by the action of the laser near the critical surface. This electron beam can accelerate 

the plasma by non-uniform Ohmic heating and consequent introduction of pressure gradients, 

as well as by the j x B force induced. 

In this paper we will firstly put our work on short-pulse laser generated shock waves into 

context by summarizing the Fast Ignition approach to Inertial Confinement Fusion and the role 

of fast heating effects. Secondly we will describe our theoretical investigation of the 

hydrodynamic processes caused by the rapid heating of a plasma by a fast electron beam. 

Finally, we will report on a recent experiment in which detailed measurements of a shock wave 

generated by a short-pulse laser were made. 
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8.2 Fast ignition 

In the fast ignition approach [1] to inertial confinement fusion (ICF) [2] a laser with a focused 

intensity on the order of 1025W/m2, and pulse length on the order of 10ps, interacts with a dense 

plasma target containing fusion fuel. The dense target is formed by the implosion of a spherical 

shell containing cryogenically frozen deuterium-tritium (DT). The implosion is driven by a 

pulse of radiation lasting approximately 10ns. This radiation may be in the form of either soft 

x-rays or focused laser beams. The incident intensity at the surface of the capsule is roughly 

1018W/m2. At the end of the implosion process, when the fuel “stagnates” up against itself at 

the centre, the DT is compressed to thousands of times its normal solid density of 220kg/m3. 

A range of variants upon the fast ignition principle have been thought of [3,4,5], however the 

basic principle is similar in all cases. The secondary laser acts, by some means, to heat a small 

portion of the imploded DT fuel to the conditions required for thermonuclear ignition. 

Ignition in the context of ICF takes place in a hotspot. The hotspot is a region of fuel in which, 

as the name suggests, the temperature is significantly higher than in the bulk of the DT fuel. 

This hotspot may be formed by compression, as in the case of conventional ICF, or by means 

of a secondary driver, as in the case of fast ignition. Ignition occurs when the hotspot is able to 

self-heat from the conditions in which it is left by the driver (Tion ≈ 10-12keV) to a much higher 

temperature of around 70keV. Once the hotspot is burning vigorously, the power radiated into 

the surrounding “cold” fuel, in the form of thermonuclear alpha particles, is sufficient that the 

burn readily spreads. It is important that the bulk of the fuel is heated to ignition temperatures 

by the spreading thermonuclear burn wave rather than by the driver. If this were not the case 

then the driver would have to be excessively large and the available energy gain insufficient 

for the purposes of electrical power production. 

In the case of fast ignition, the hotspot is formed in a region near the surface of the compressed 

fuel mass. The hotspot is surrounded by lower density material of similar temperature on one 

side, and by material of similar density and much lower temperature on all others. This means 

that, during its formation, the hotspot is far from being in pressure equilibrium with the 

surrounding plasma and will tend to expand rapidly. Where the hotspot faces the cold dense 

fuel, this expansion is led by strong shock waves. 
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In order that we can properly formulate the ignition problem, it is critical to quantify both the 

hotspot expansion and shock wave generation and propagation processes. The driver must 

deposit its energy in a hotspot that is continuously evolving in size and density, and the 

thermonuclear burn rates at any point in time are a strong function of the density profile of the 

DT fuel. The situation is complicated by the fact that in fast ignition the intense laser pulse acts 

to drive enormous currents as well as ultra-strong magnetic and electric fields. In order to tackle 

the evolving hydrodynamics therefore we must take into account the possibility of 

magnetohydrodynamic effects such as the JxB force on the fluid. 

In addition to the evolution of the hotspot, there is also the issue of hydrodynamic motion in 

other regions of the target.  The fast electrons will heat any material present between the point 

of laser absorption and electron deposition in the hotspot. The heating duration (10-20ps) is 

sufficient for some regions to experience significant hydrodynamic motion during this time, 

which in turn can affect the transport of fast electrons to the hotspot.  This effect has not been 

thoroughly studied. 

To summarize, the pursuit of fusion energy via Fast Ignition ICF requires one to consider a 

situation where shock wave generation by rapid heating of a plasma with a high energy 

relativistic electron beam is important and impinges on many facets of the whole problem.  This 

largely motivates our current efforts to study this form of shock wave generation. 

8.3 Modelling of shock waves generated by intense laser-plasma interaction 

When a laser of focused intensity 1022-1025W/m2 interacts with dense fuel, it accelerates 

electrons from the plasma background to approximately MeV energies. These electrons 

propagate forward into the dense fluid beyond the critical surface. These high energy electrons 

have relatively long mean free paths and, to a fair approximation, propagate ballistically. 

However, in order to conserve charge, a so-called “return current” is drawn from the plasma 

background. This return current is collisional, and is therefore subject to the resistivity of the 

medium. We can therefore write, 

𝑗𝑓𝑎𝑠𝑡 + 𝑗𝑟𝑒𝑡𝑢𝑟𝑛 ≈ 0   Equation 2   

and thence, 

𝐸 = 𝜂𝑗𝑟𝑒𝑡𝑢𝑟𝑛 = − 𝜂𝑗𝑓𝑎𝑠𝑡  Equation 3   
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where  is the resistivity of the background plasma. For plasma at temperatures in excess of 

100eV (11.8 Million Kelvin), at solid densities, the resistivity is given approximately by the 

Spitzer formulation as:  

𝜂 = 10−4 𝑍 ln Λ

𝑇𝑒𝑉
3 2⁄    m   Equation 4   

Where Z is the atomic number and ln Λ is the dimensionless plasma parameter. The 

background plasma is heated such that, 

𝜕𝑇

𝜕𝑡
=

𝜂𝑗2

𝑘𝐵𝑛𝑒
   Equation 5   

Since the current is not uniformly distributed throughout the plasma, this Ohmic heating leads 

to pressure gradients that drive expansion and shock wave formation. Furthermore, by 

combining Faraday’s Law and Ohm’s Law, it can be seen that the growth of the magnetic 

field in the plasma (assuming current flowing along the y-axis) is given by: 

𝜕𝐵𝑍

𝜕𝑡
+ 𝑣𝑥

𝜕𝐵𝑍

𝜕𝑥
= −

𝜕(𝜂𝑗𝑦)

𝑑𝑥
  Equation 6   

This results in a JxB force on the background plasma in addition to the influence of the kinetic 

pressure. 

8.4 Magnetohydrodynamics simulations of laser-generated electron beam 

driven strong shock waves 

A magnetohydrodynamics simulation code has been written [6], based upon the methods 

described by Ziegler in reference 7. As can be seen from figure 1, the generation of strong 

shock waves is anticipated on timescales of only a few picoseconds. 
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Figure 1. Showing the formation of strong shock waves driven by a cylindrically 

symmetric continuous current profile with amplitude of 6x1017Am-2, Gaussian 

distributed about the cylinder-axis with a FWHM of 7m. Background is hydrogen at 

400kg/m3. The heated region is centred on r=0. The outward propagating density features 

clearly show the rapid formation and propagation of strong shock waves from the 

periphery of the heated region. 

A wide ranging parameter scan was performed in order to determine the timescales for shock 

wave formation with a range of background plasma densities and drive currents. It is important 

to consider a wide ranging parameter space, since, even in the case of fast ignition, electrons 

must traverse a wide range of plasma densities between the point where they are generated by 

the laser and their being absorbed in the dense fuel. The results of this study are shown in figure 

2. Here it is assumed that shocks are formed whenever material is accelerated to above the 

sound speed in the background plasma. 
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Figure 2. Timescales for shock wave formation in a variety of different current and 

plasma density regimes. 

In fast ignition, it is necessary to raise a region of fuel with a r of approximately 5kg/m2 to a 

temperature of around 12keV. Assuming a cylindrical hotspot with initial density of 

approximately 3x105 kg/m3 and given that the heat capacity of DT is around 100GJ/kg/keV, 

then this correlates to raising 8.73g of DT to 12keV. This requires approximately 10.5kJ of 

energy to be deposited. Presuming a time scale for depositing the energy of around 20ps, this 

necessitates a heating power of around 0.5PW must be supplied to the cylinder. Assuming the 

energy enters the cylinder from one end, then the power density must be around 6x1023W/m3. 

In order that the heating be localized to the hotspot, electrons with energy of around 1MeV 

must be employed. This gives a total minimum beam current of around 6x1017A/m2.  The data 

shown in figure 2 suggests that shock waves would form around 6ps into such a 20ps ignition 

pulse. Therefore, at the moment of ignition the hotspot would be rarefied and bounded by 

strong shock waves where it interfaced with the cold dense fuel mass. It is clear, therefore, that 

in modelling fast ignition it is important to properly take into account the effects of such shock 

waves upon the ignition process, and also in the deposition of energy by the driver. 
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These calculations also suggest the utility of short pulse lasers for generating extremely strong 

shock waves for laboratory investigation. For instance, the shock wave in figure 1 is 

propagating at approximately 900km/s.  Furthermore, the results of the simulations, taken 

together with other analyses presented in reference 6 clearly demonstrate that MHD effects 

play no significant role in the parameter range explored here, and that the driving of shock 

waves is due entirely to the steep kinetic pressure gradients accelerating the fluid. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

P a g e  | 130 
 

 

PowerLaPs 

 

Innovative Education & Training in High Power Laser Plasmas 

Computational Modeling & Simulations in Laser Matter Interactions  

 

Chapter 9: Parallel algorithms for LLP 

simulations 

 

 

J. Vyskocil 

 

 

 



 
 

P a g e  | 131 
 

 

 

 

 



 
 

P a g e  | 132 
 

 



 
 

P a g e  | 133 
 

 

 



 
 

P a g e  | 134 
 

 



 
 

P a g e  | 135 
 

 



 
 

P a g e  | 136 
  



 
 

P a g e  | 137 
 

 



 
 

P a g e  | 138 
 

 



 
 

P a g e  | 139 
 

 

 



 
 

P a g e  | 140 
 

 



 
 

P a g e  | 141 
 

 



 
 

P a g e  | 142 
 

 

 



 
 

P a g e  | 143 
 

 

 

 

PowerLaPs 

 

Innovative Education & Training in High Power Laser Plasmas 

Computational Modeling & Simulations in Laser Matter Interactions  

 

Chapter 10: Astrophysics with high-power 

lasers 

 

 

A. Ciardi 

 

 



 
 

P a g e  | 144 
 

10.1 From laboratory plasmas to astrophysical plasmas  

10.1.1 Macrophysics-Microphysics 

Broadly speaking high-energy density laboratory astrophysics studies can be divided 
into those addressing the 
 

• microphysics: equation of state, opacities, . . . Where plasma conditions in the 
laboratory are the same as those found in space 
 

• macrophysics: shocks, jets, particle acceleration, magnetic reconnection, . . . 
Where the plasma conditions in the laboratory are a “scaled” version of those 
found in space. 
 

10.1.2 High-energy density laboratory astrophysics 

Typical plasmas on z-pinch and laser facilities have pressures of ~Mbar, 
corresponding to energy densities ~1012 erg cm-3, at a fraction of solid density. An 
overview of the plasma conditions attainable on experimental installations, together 
with some of those found in space are shown in the figure. To obtain such conditions, 
z-pinch facilities rely on stored electrical energy (hundreds of kJ) to deliver large 
currents (~ of a few Mega Amperes) over a short time (~ 100-1000 ns) to a “load” 
usually consisting of a gas or thin metallic wires and produce typical volumes of plasma 
~1 cm-3. Laser facilities instead rely on focusing onto a solid or gaseous target a high-
power laser beam, or beams. These concentrate several kJ of energy, over timescales 
~pico- to nano-second, into plasma volumes of ~1 mm-3. The Laser Megajoule (LMJ) 
facility in France and the National Ignition Facility (NIF) in the USA, can produce fusion 
plasmas under conditions similar to stellar interiors. Producing plasma conditions 
similar to those found in space is not always necessary for the laboratory study of 
astrophysical phenomena. For the present discussion it is more interesting to look at 
the dynamical conditions that can be obtained in the laboratory. For example, the 
typical energies available on z-pinches and lasers, when partially converted into kinetic 
energy, can generate hypersonic (Mach numbers M > 5), radiatively cooled flows with 
characteristic velocities of the order of 100 - 1000 km s-1. These can include 
dynamically important magnetic fields, ~several 106 Gauss, and a large range of 
plasma-β (the ratio of thermal to magnetic pressure), 1 >> β >> 1. Then, our inability 
to obtain the adequate plasma conditions may be overcome by producing scaled 
“conditions” of the phenomena of interest. 
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10.2 Mass ejection in young stars 

Jets are ubiquitous in space. In general, jets are thought to be powered by the 
combination of rotation and magnetic fields, which extract the rotational energy from 
an accreting system and create magnetic stresses which accelerate and collimate the 
flow. Depending on the details of the models, the winding of an initially poloidal 
magnetic field results in a flow pattern dominated by a toroidal field. A similar situation 
is also attained when the foot-points of a field line, connecting the disc to a central 
compact object or connecting different parts of a disc, rotate with different angular 
velocities. 
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10.2.1 Basics of jet numerical modelling 

Collapsing prestellar dense-cores 
3D modelling is limited to the early stages (tens of thousand of years) of jet evolution 
Essentially limited to the slow outflow components (protostar either not there or just 
formed) 
The jet and disk are treated “self-consistent” 
Disk included (and star) 
Start with an initial star-disk/ambient structure and large-scale poloidal field 
Essentially limited to 2D and relatively short time-scales 
Jets can have a feedback on the disk and star 
Disk (or Poynting flux injection) as a boundary condition 
The magnetic field distribution, rotation and mass injection at the base of the jet are 
imposed as boundary conditions or initial conditions. 
There is no jet/wind feedback on the disk 
Simulation in 2D and 3D over long time and spatial scales are possible 
Gravity is often neglected 
 

 
 
10.2.2 Modelling jets as ideal-magnetofluids 

Scaling the laboratory to astrophysical dynamics relies on MHD being applicable. That 
requires the advection of momentum, magnetic field and thermal energy to dominate 
over their diffusion. This can be quantified by three dimensionless number. 
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10.2.3 Compressible, radiative magneto-hydrodynamics: Why is it important? 

It is only recently that compressible, radiative MHD flows can be produced in the 
laboratory, and in general astrophysics codes are not validate on real data. For 
example even different numerical schemes, within the same code, can give largely 
different answers. Laboratory data can help better understand and constraint the 
numerical models. Other examples of the importance of laboratory data is the need to 
test microphysics models for both astrophysical and laboratory codes. 

 
10.2.4 Experiments and 3D simulations show kink-unstable jets 

The basic astrophysical mechanism studied in the z-pinch experiments is the 
interaction of a toroidal magnetic field with a plasma ambient medium, leading to the 
formation of jets and magnetic “bubbles”. The plasma ablated from the wires is 
accelerated vertically filling the space (few cm) above the array. Below the wires there 
is only a toroidal magnetic field. The initial formation of the magnetic cavity, and jet 
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occurs at the time when the magnetic pressure is large enough to break through the 
wires. This occurs only over a small region close to the central electrode, where the 
vacuum toroidal field is strongest. The results show the system evolving into a 
structure consisting of an approximately cylindrical magnetic cavity with an embedded 
jet on its axis confined by the magnetic “pinching" force. A shell of swept-up plasma 
surrounds and partially confines the magnetic bubble. The subsequent evolution is 
dominated by current-driven instabilities and the development of the asymmetric “kink” 
mode (m = 1) which leads to a distortion of the jet and a re-arrangement of the 
magnetic field. The end result of the instabilities however is not to destroy the jet, but 
to produce an inhomogeneous or “knotty" jets. Simulations show that the resulting jet 
has typical super-fast-magnetosonic Mach numbers in excess of 5, it is kinetically 
dominated and its opening angle < 20o. 
 

 
 

10.2.5 Poloidal collimation in the astrophysical context  

It is worth pointing out that while two-dimensional, axisymmetric MHD simulations, 
reproduce very well the experimental results up to the development of the non 
asymmetric current-driven instabilities, there are fundamental differences in the long 
term evolution of the system, which can only be captured by fully three-dimensional 
simulations. 
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10.3 Mass accretion in stars 

Mass ejection in young stars is thought to be multi-component: stellar wind, 
magnetospheric ejections and disk wind. These components, and their magnetic field, 
interact with each other in complex ways and a complete picture of their dynamics 
does not yet exist. 
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10.3.1 Magnetospheric accretion: mass transfer from disk to stars 

The accretion of mass from a disk is mediated by the magnetic field of the star. 
Magnetized accretion funnels channel the mass onto the stellar surface where an 
“accretion” shock is formed. Emission in the x-ray band from the shock is reprocessed 
by the environment and observed as an “excess luminosity” with respect to the stellar 
photosphere emission. 

 
 
10.3.2 Magnetized accretion columns in the laboratory 

The jet and target material were made of different materials. Using x-ray spectrometry 
the “mixing” of the two materials was quantified. 
 

 
11.3.3 Magnetized laboratory accretion columns 

Impact of the accretion ow ablates the target material and it is ejected to distances of 
~2 mm from the initial target surface. The shell of material surrounding the accretion 
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shock is mostly made of target material. Astrophysical simulations show a similar 
effect, with the chromosphere making up most of the dense shell. 
Laboratory simulations show that the shell interface with the external medium (the 
corona) is unstable to the magnetized Rayleigh-Taylor instability. The instability can 
generate more material mixing. The take away message is that 2D simulations are 
unable to capture instabilities and chromospheric ablation can be important. 
 

 
10.4 Magnetic reconnection and particle acceleration 

10.4.1 Introduction 

Magnetic reconnection changes the topology of the magnetic field and releases 
magnetic energy in the form of bulk plasma kinetic energy, thermal energy and 
energetic charged particle. Astrophysical systems usually have very large Lundquist 
number (S>>1010) (i.e. large ratio of Ohmic diffusion time to the crossing time of Alfven 
waves). 

• the reconnection rate in collisionless plasma is faster than in the standard 
Sweet-Parker reconnection rate 
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10.4.2 Particle acceleration in magnetic reconnection 

Several particle acceleration mechanism are possible in the reconnection layer. For 
typical parameters for the Omega Laser Facility, electrons are expected to gain 
energies ~ 25-75 keV, which should be compared to their thermal energy ~1 keV. 
 

 
10.4.3 Magnetic reconnection in z-pinch experiments: anomalous ion Heating 

Experiments on magnetic reconnection in high-energy density plasmas are also 
carried out on other facilities besides lasers. On z-pinch machines, wire ablation is 
used to generate converging, magnetized plasma flows that meet to generate a 
reconnection layer. Because of the longer time- and spatial scales, these experiments 
provide in general easier diagnostic access than laser experiments. The magnetic field 
measurements by Faraday rotation show a Harris-type current sheet, indicative of 
magnetic reconnection. Temperature measurements with Thomson scattering show 
anomalous ion heating Ti > Te. 
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11. Atomic Physics Simulations for Plasmas 

Detailed knowledge of atomic physics of laser-produced plasmas (LPP) is important both for 

plasma diagnostics and for applications of LPP as a short-wavelength radiation source. 

Emission and absorption spectra are very important tools of plasma diagnostics containing 

information about electron and ion temperatures, plasma density and ion charge distribution. 

Laser-produced plasmas from targets of medium and heavy elements are efficient pulsed 

point-like sources of extreme ultraviolet (EUV) and X-ray radiation that are suitable for 

applications such as EUV lithography and imaging of biological objects in the water-window 

spectral range. For these applications, suitable laser and target parameters have to be found 

and optimized. 

Detailed simulations of atomic physics include two basic tasks. First, atomic structure 

modelling is performed to calculate energy levels, wave functions and transition probabilities. 

Second,populations of ionization and excitation states are calculated for given density, 

temperature and plasma size or for known history of the above parameters. External source 

of radiation can be also taken into account. Then, plasma emission or absorption spectra may 

be synthetized. The second task can also be solved as a post-processor to a plasma dynamics 

code. 

Various simplified approaches that are used for calculations of mean ion charge and 

for the radiative transport of energy in the fluid approach to simulations of plasma dynamics 

are not discussed in this section. 

 

11.1 Introduction to simulations 

Atomic structure codes can be divided into 2 groups - codes solving non-relativistic 

Schrodinger equation with relativistic corrections and fully relativistic codes solving Dirac 

equation. Nonrelativistic codes include the configuration interaction codes CIV3 [1] and 

SUPERSTRUCTURE [2], the multi-configuration Hartree-Fock code MCHF [3] and the very 

popular Cowan code [4]. Fully relativistic codes include the HULLAC package [5], the SZ code 

[6] and the popular modern FAC (Flexible Atomic Code) code [7]. 

The fully relativistic approach based on the fully consistent physics description is more 

computationally demanding but it can be performed on modern personal workstations. 

However, students at advanced bachelor and master levels are well familiar with the 

Schr¨odinger equation that is the base for the classical approach and the interpretation of code 

results is significantly simpler. Thus, this subsection is based on the classical approach with 

relativistic corrections. Here, we shall briefly explain the atomic structure and the process of 

its calculation essentially according to the Cowan’s book [4]. 
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11.1.1 Basic notations 

Ionization degrees are often marked by Roman numerals where I denotes neutral 

atom, II is singly ionized ion, III doubly ionized ion and so on. Generally, Roman numeral is 

equal to the ionization degree+1. For example, the triply ionized boron is denoted B IV. On 

the other hand, there is certain similarity of spectral features of ions with the same number of 

bound electrons. The emission spectra of ions with only one bound electron have a certain 

similarity with the spectrum of neutral hydrogen, so these ions are classified as H-like 

(hydrogen-like). Similarly ions with two bound electrons are called He-like (helium-like). Thus, 

ion B IV is called helium-like boron, as it has two remaining bound electrons. Atomic states of 

a particular ion include ground state (the state with minimum energy for an ion with given 

degree of ionization), excited states (also called resonance states) with one electron from the 

outmost shell excited to an upper shell or subshell and autoionization states with energy higher 

than the ionization potential. Autoionization states have either one electron excited from an 

inner shell or more excited electrons. Spontaneous ionization is possible from an 

autoionization state. 

We shall use here cgs units. Radii will be normalized to the Bohr radius a0 = n2/me e2 = 

5.29177 10−9 cm and energies will be expressed in Rydbergs 1 Ry = 1 R∞ = e2/2 a0 = 13.6058 

eV = 109737.3 cm−1. 
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11.1.2 One-electron atom (ion) 
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11.1.3 
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11.2 Population of states and spectra synthesis 

 

11.2.1 
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11.2.2 

 

11.2.3 
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11.3 
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11.4 References 
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AIM  

The aim of the Finite Element Method - FEM, Lab session is to provide to the attendants the 

ability of understanding and implementing simulations of laser mater interaction problems. 

 

1. LS-DYNA  

LS-DYNA from Livermore Software Technology Corporation (LSTC), is a highly advanced 

general purpose nonlinear finite element program that is capable of simulating complex real-

world problems. The distributed and shared memory solver provides very short turnaround 

times on desktop computers and clusters operated using Linux, Windows and UNIX.  

LS-DYNA is suitable to investigate phenomena involving large deformations, sophisticated 

material models and complex contact conditions for structural dynamic problems. LS-DYNA 

allows switching between explicit and different implicit time stepping schemes. Disparate 

disciplines, such as coupled thermal analyses, Computational Fluid Dynamics (CFD), fluid-

structure interaction, Smooth Particle Hydrodynamics (SPH), Element Free Galerkin (EFG), 

Corpuscular Method (CPM), Discrete Element Method (DEM) and the Boundary Element 

Method (BEM) can be combined with structural dynamics.  For pre- and post-processing, LS-

DYNA comes with the LS-PrePost tool. LS-PrePost can be utilized to generate inputs and 

visualize numerical results. 

 

1.1 Keyword format input files  

An LS-DYNA input file is a text-file in so called Keyword format usually with a *.k, *.key or 

*.dyn suffix, e.g. laser.k. A finite element model in LS-DYNA is built up by different keywords, 

which is defined for all ingoing definitions and parameters in a model (e.g. *PART, *NODE). A 

short overview of the basic structure of such an input file for a basic 1 element finite element 

model is provided. 
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Consider a cube consisting of one element with eight node points as shown in Figure 1.1. 

 

Figure 1.1 Cube consisting of one element with eight node points 

 

The *PART keyword is used to begin the definition of the finite element model. The keyword 

*PART contains data that points to other attributes of this part, e.g. material properties. 

Keywords for these other attributes, in turn, point elsewhere to additional attribute definitions. 

The organization of the keyword input for the cube looks like this: 

 

 

A brief description follows: 

*PART: We have one part with identification pid=1. This part has attributes identified by section 

identification secid=1 and material identification mid=1. 
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*SECTION_SOLID: Parts definitions that reference secid=1 are defined as constant stress 8 

node brick elements (elform=1). 

*MAT_ELASTIC: Parts definitions that reference mid=1 are defined as an elastic material with 

density, Young’s modulus and Poisson’s ratio. 

*ELEMENT SOLID: The element with identification eid=1 are defined by nid=1 to nid=8 and 

belongs to pid=1. 

*NODE: The node identified by nid has coordinates x,y,z. 

 

Boundary conditions and time dependent loads are also set by keywords and are usually 

applied on nodes, elements, segments or parts. Set definitions are often used to define groups 

of these entities. Since all loads are time dependent, curves need to be defined that states 

time vs load unit (force, pressure etc.). 

 

One example of defining boundary conditions and loads on the cube looks like this: 

 

 

About the keywords above: 

*BOUNDARY_SPC_SET: The node set with identification nsid=1 are constrained in y-

translation and x- and z-rotations. 

*SET_NODE_LIST: This keyword defines that node 1, 2, 5 and 6 belongs to node set sid=1. 

 

*LOAD_SEGMENT: A pressure load is applied on a segment that are defined by node 4, 8, 7 

and 3. 

*DEFINE_CURVE: The curve consists of two points that defines the time vs pressure. This 

curve with identification lcid=1 is used for the load. 
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1.2 Consistent units 

On the table below are presented consistent units for using LS-DYNA. The inappropriate 

selection of consistent units is one of the most common error done by the user. 

 

Table 1.1 Consistent units using LS-DYNA 

 

2. LS-PrePost 

LS-PrePost is an advanced pre- and post-processor designed specifically for LS-DYNA. It is 

developed for Windows, Linux and Apple and it is free to download from the web link 

http://ftp.lstc.com/anonymous/outgoing/lsprepost/4.5/. 

LS-Prepost main functions contain: 

• Full support of LS-DYNA keyword files 

• Full support of LS-DYNA result files 

• Robust handling of geometry data (new CAD engine)   

• Pre-processing (meshing, model clean-up, entity creation)    

http://ftp.lstc.com/anonymous/outgoing/lsprepost/4.5/
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• Post-processing (animation, fringe plotting, curve plotting)  

  

2.1 Input and output files 

           Input  

FEM:  LS-DYNA Keyword, Nastran, I-DEAS Universal, PAM-CRASH, RADIOSS, ABAQUS  

           CAD:  IGES, STEP  

           ASCII:  glstat, matsum, etc.  

           Binary:  d3plot, binout, etc.  

            Output 

 FEM:  LS-DYNA Keyword, Nastran  

Image:  PNG, TIFF, BMP, GIF, JPG, PostScript  

Movie:  AVI, MPEG, Animated GIF, JPEG  

XY Data:  CRV, CSV, XML o CAD: IGES, STEP, STL  

              Other:  Post.db, Project File  

 

2.2 Mouse and Keyboard  

Dynamic Model Operation  

Rotate:  Shift + Left-click  

Translate:  Shift + Middle-click 

 Zoom:  Shift + Right-click/Scroll-wheel 

 

Graphics Selection  

Pick (single):  Left Click o Area (rectangle):  Left-click + Drag  

Poly (polygon):  Left-click at corners / Right-click to finish  

List Selection 

               Multi-Select: Left-click + Drag / Ctrl + Left-click  

 

2.3 Graphical user interface  

The graphical interface of LS-PrePost is shown in Figure 2.1.  On the right hand side, you 

can see the main toolbar. When clicking on one of these, a sub-toolbar just to the left will be 

shown. That is the location where you’ll find most of the tools needed to create/modify/delete 

entities in your model.   

In the bottom toolbar, are found the tools which are the most commonly used to determine 

how LS-PrePost should render mesh/surfaces, orient the model, etc. There are a couple of 
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the drop-down menus on the top left corner that you will use more or less frequently: 

File/View/Application/Settings. The Floating Toolbar is used to toggle between different views.   

 

Figure 2.1 Graphical interface of the LS-PREPOST 

 

2.4 Menus  

In this section are presented the useful menus for the user, the File Menu, the Geometry Menu 

and the FEM menu. 
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Figure 2.2 File menu 

 

Figure 2.3 Geometry menu 
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Figure 2.4 FEM Menu 

 

3. Getting started 

3.1 Purpose 

The purpose of this tutorial is to get familiar with the pre- and post-processing tools in LS Pre-

Post and also the basics of the LS-DYNA solver. 

3.2 Problem Description  

Consider the deformation of a cube on the ground with an applied pressure on the top surface.  

The task is to compute the vertical displacement of the cube due to this pressure.  

 

  

 

Material properties  

   Density, 𝜌    7850 kg/m3  

Young’s modulus, 𝐸  210 GPa  

Poisson’s Ratio, 𝜈  0.3 0.3 
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3.3 Data files and unit system 

The code can be found in cube_results.k  

The S2 unit system is used in this tutorial  

 

 

 

3.4 Preparation LS-PrePost  

The most common way to work with/open LS-PrePost is to have a short-cut on the desktop 

directly. This gives you control over which version of LS-PrePost you would like to use and 

you can easily update LS-PrePost separately.  

 

3.4.1 View settings  

In LS-PrePost, go to View > Toolbar and activate Text and Icon (Right) 

and Text and Icon (Bottom). This is done to easier navigate through the 

different toolbars.  

Check so you can see your 

Floating Toolbar in the LS-

PrePost window.  

  

  

If not, activate it by clicking on Opti > ISO View in the bottom toolbar.  
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3.5 Create model  

3.5.1 Geometry and mesh  

• Click Mesh > ShapeM (always use the menu on the right side, 

if nothing else is mentioned).   

• Enter the values as in the picture to create a 1000x1000x1000 

mm solid cube with two elements in the x-, y- and z-directions.   

• Set Target Name to Cube.  

• Click Create, Accept and then Done.  

If you can’t see your mesh, activate Mesh in the bottom toolbar.  

   

 

 

 

 

 

 

 

 

 

 

3.5.2 Boundary conditions  

Apply boundary conditions to fix one side of the cube: 

• Click Model > CreEnt 

• In the Entity Creation box, double-click on Boundary and click Spc in the dropdown 

that appears.  

• Select Cre 

• Set shall be activated. 

• Select XOZ as Sym Plane, Y, RX and RZ will then be activated. The boundary 

conditions will then have a translational constraint in global y –direction and rotational 

constraints about x- and z-axis. 

• From the ISO-views on the top of the screen, click at the one called Top. 
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Check that your coordinate system looks like the one above. To show the coordinate system, 

click Opti and activate Triad.  

 

This box shows alternatives to select the nodes. Select 

Area.  

    

 

 

• Select the nodes in the yellow square by making 

a box with the mouse.   

• A node set will be created from the nodes that 

were chosen, NSID = 1 in Entity Creation indicates 

that it will get an Id = 1.  

• Click Apply, then Done in the Entity Creation 

box.  

The nodes are now constrained.  
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3.5.3 Apply the load  

For loads, a curve must be defined that states the variation of the load over time. Click Model 

> Keywrd. In the dialog window that opens, there one can change between Model and All.  

Model shows the keywords that already have been created. All shows all possible keywords 

that are available in LS-DYNA.  

Select All at the top of Keyword Manager window. Double-click DEFINE > CURVE. Name the 

curve Curve – Pressure for example. All titles are optional, but it is good practice to make 

use of them to make the model clear and structured.   The points for the curve will be written 

in A1 and O1:  

 

 
  

• Write 0 and 0, Click Insert.  

• Then 1 and 1, Insert.  

• Finally, 1.1 and 1, Insert.  

• Click Accept  

  

It is important that the curve extends beyond the end time of the simulation. The simulation 

will have the termination time 1 s (will be set later). Therefore, the last point of 1.1 was added.  
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To view the curve, Click Plot. Close the PlotWindow (X or Quit) and the *DEFINE_CURVE 

(Done) window. 

  

 
  

Now click Model > CreEnt:  

  

• In the Entity Creation box, double-click on Load and click on 

Segment in the dropdown that appears.  

• Click Cre  

• Change Type: to LOAD_SEGMENT_SET.  

• Give the load the title Pressure.  

• Click on LCID and select 1 Curve – Pressure, press Done.   

• To obtain a pressure of 10 MPa, the scale factor SF will be used.  

• Set SF to 10 (the pressure unit is MPa for the selected unit system).  

• From the selection box, Pick can be activated.  

• Click on the four segments on the top of the cube, as in the figure. If necessary, 

deactivate entities with right mouse button.   

• Click Apply, then Done   

 

3.5.4. Termination  

The end time for the simulation needs to be set. This keyword is almost always mandatory for 

any simulation using LS-DYNA:  

• Click Model > Keywrd.   
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• Double-click CONTROL > TERMINATION  

• Set ENDTIM to 1. The simulation will then last for 1 time unit, which is second in this 

case.  

• Accept, then Done.    

  

 

3.5.5 Output  

The user must request all the data needed to post-process an analysis using LS-DYNA, before 

starting the simulation. We will create something called d3plot, which gives complete output 

states of the simulation:  

• Click Model > Keywrd.   

• Double-click DATABASE > BINARY_D3PLOT  

• Set DT to 0.1. This implies that results will be printed every 0.1 time unit.  

• Accept, then Done  

 

 
  

 

3.5.6 Material properties  

• To create a material card to define the material properties:  

• Click Model > Keywrd   

• Double-click MAT > 001-ELASTIC. This is an isotropic elastic materia   

• Name the material to Steel.  

• Set the material properties RO, E and PR as in the figure below (also stated in section 

1.3). 

• Click Accept, then Done.   
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3.5.7 Element properties  

The element type to be used:  

• From Keyword Manager, double-click SECTION > SOLID.  

• Name the section to Cube  

• Use ELFORM = 1, which is the default element formulation. 

• Click Accept, then Done.  

 

 
  

Now apply the material and element properties to the part. Since the part already is created, 

one can activate Model, instead of All, in the Keyword Manager. This makes it easier to 

navigate through the list of keywords.  

• Double-click PART > PART  

• Click on the black dot next to SECID, defined entities will then be shown Select your 

newly created section (1 Cube) and Accept and then Done  

• Do the same thing for MID. Click Accept, then Done.  

The result should be as shown below.  

 

 

 

3.5.8 Check the model before running  

Now check for errors using the Model Check:  

• From the top menu, click Application > Model Checking > General Checking.   

• Switch to Keyword Check. The warnings and error should not exist.  

• Click Done.  
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Note that even if no errors or warnings occurs, the model can still be incomplete or wrong. 

There is no way for any pre-processor to know your intended use of the model. Hence, the 

loadings and boundary conditions can only be checked if they make any sense, not if they are 

correct with respect to your load case.  

 

 
  

    

 

3.5.9 Save and run the simulation  

It is preferable to run each simulation in a separate folder, thus create one before saving if you 

have not done so, e.g. CUBE. First save the finished keyword model from LS-PrePost in the 

new “CUBE” folder that you have created on your computer using File > Save As > Save 

Keyword As. Use the file name cube.k, note the .k suffix.   

 

To how to run the simulation, you will be given orders from the instructor. 

    

3.5.10 Post processing  

To visualize the results, you need to open the d3plot result file. This is done by selecting 

File>Open>LS DYNA Binary Plot. Once Binart Plot is opened, the animate toolbar is the tool 
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that enables you to step through the different states of the simulation. Hold the mouse over 

the different buttons, a text box will pop up and show information about the different 

possibilities using the animator toolbar. Play around with the buttons to see what happens. 

Note that the deformations are very small, therefore you will probably not notice that anything 

happens with the cube.   

  

 
  

To easier see what happens, you can scale up the deformations:  

• Click Settings > Post Settings in the top menu.  

• Select Displacement Scale Factor, write 5000 as the factor. X, 

Y and Z shall be activated, which implies that the displacements 

will be scaled in all directions.  

• Click Apply, then Done.  

Play around with the animate toolbar again and see how the cube 

deforms.  
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Then plot the deformation history as a curve:  

• Click Post > History.  

• In the History Box, select Nodal > Y-displacement. 

• Select a 

node on the top 

of the box.  

• Click Plot.  

 

 

 

 

 

 

 

 

 

 

 

 

In the Plot Window, Y-displacement vs Time are stated. Zoom by pressing Ctrl and make 

a box with the mouse. A right-click will reset the window to original. Zoom in on the curve 

around Time=1, click on the final state.  

Note that the Y-displacement is -0.0476 mm.  
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When you click on the curve, information about the picked point will be stated in the Message 

box, which is located at the bottom of the LS-PrePost window. If you double-click in this box, 

a bigger box will pop up.  

  

Close the Message box and Plot Window.  

  

 
  

    

Now, click Post > FriComp> Ndv > y-displacement. Use the Animate toolbar and go to the 

last state. The values in the Fringe Level shows that the maximum y displacement is -4.761e-

02 mm. 
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3.5.11 Analytical solution  

The analytical solution of the vertical displacement due to a 10 MPa pressure load is derived 

from Hooke’s law.   

 
The simulation result should be nearly identical to the analytical solution.  

4. Exercises  

There are several possibilities to try out different features in LS-DYNA with this simple model. 

What happens if you change:   

• material?  
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• boundary conditions?  

• element formulations?  

• load level?  

 

 

References 
Tutorials taken from: https://www.dynasupport.com/tutorial/introduction-ls-dyna-ls-prepost-

for-explicit-and-implicit-analysis  

https://www.dynasupport.com/manuals 
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Tensile test 

1.1 Problem Description  

The task is to perform a tensile test on a flat specimen. The end of the specimen is constrained 

while a prescribed motion is applied on the other end. The task is to compare the stress vs. 

strain curve in an element when the uniaxial tension test is simulated using the explicit solver 

in LS-DYNA.  

 

 

1.2 Data files    

The geometry that will be used - tensile_test.k. and the whole code tensile_test_results.k  

•  

2. Explicit structural analysis  

2.1 Read geometry  

Open tensile_test.k in LS-PrePost, which contains the geometry of the test specimen.   

 
  

2.2 Material properties  

LS-DYNA accepts, for most materials, input in terms of true stress vs. true strain. Normally an 

experimental uniaxial tension test is performed and engineering stress and strain data are 

obtained. Before these data are used as an input in a material model in LS-DYNA, they are 

converted to true stress and strain. The curves behave as in the figure.  

Engineering stress is the applied load divided by the original cross-sectional area of a material, 

while true stress is the applied load divided by the actual cross-sectional area (changing area 

with respect to time) of the specimen at that load. 

Material properties  

   Density, 𝜌     
                   7850kg/m3  

Young’s modulus, 𝐸    
                210 GPa                

 

Poisson’s Ratio, 𝜈  0.3  

   Yield limit    250 MPa  

Tangent modulus  1000MPa   
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Figure 2.1 Engineering and true stress-strain curves 

 

To create the material card: 

Click Model > Keywrd. Activate All in the Keyword Manager. Double-click MAT > 024-

PIECEWISE_LINEAR_PLASTICITY, which is an elasto-plastic material.  

Define Yield stress SIGY and Tangent Modulus ETAN, which gives linear hardening.  

 

Enter the title and the values as in the figure above and click Accept, then Done.   

 

2.3 Element properties  

To set the element formulation and properties do as follows:  
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• Double click SECTION > SHELL in the Keyword Manager.  

• Enter Specimen_shell as TITLE.  

• Set T1 to 1.5 and press Enter, T2-T4 will then be changed to 1.5 as well and this defines 

the thickness of the nodes in every element.   

• Click Accept, then Done.   

 

Now go to Part in the Keyword Manager and assign the newly created material and section. 

There one can also change the name of the part, to Tensile specimen for example. Click 

Accept, then Done.  

 

2.4 Boundary conditions  

Apply the fixed boundary conditions as follows:  

• Click on the Bottom view in the Floating 

Toolbar.  

  

• Click Model > CreEnt.   

• Double-click Boundary > Spc, click Cre.  Make sure that 

Set is selected in the Entity Creation window.  

• Select Area in the node selection window (Sel.Node).  

• Make a box around the nine nodes as in the figure.  

• Fix the nodes in X- and Z-translation and all rotations. 

This is done by activating X, Z, RX, RY and RZ.   

• Click Apply.  

    
  

 Now create another boundary condition:  

• In the node selection window, write 80 in the ID box and press Enter. Write 87 and press 

Enter. Two nodes will now be selected at the outer edges of the test specimen. Fix the 

nodes in Y translation by only activating Y.   

• Click Apply.  

• Close Entity Creation window.   

  

2.5 Prescribed motion/displacement  
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For motions and loads, a curve must be defined that states the variation of the 

load/displacement/velocity etc. over time.   

First create the curve defining the motion:  

• In the top menu, click Application > Tools > CurveGen  

• Change Method to X-Y.  

• Deactivate Smooth.   

• Write X=0 and Y=0 (ignore the value of smooth)  

• Click Insert.  Then 0.01 and 1, Insert.   

• Finally, 0.011 and 1, Insert (the termination time 

will be 0.01 s for this tutorial).  

• Change Curve Name to e.g. Motion.  

• Click Create, then Done.  

Note that the curve could alternatively have been created using DEFINE > CURVE in the 

Keyword Manager. A curve created in CurveGen will contain a larger amount of points, 

compared to a curve created by DEFINE > CURVE.  

Now apply the motion to the end of the tensile specimen:  

• Click Model > CreEnt.  

• In the Entity Creation window, double-click Boundary 

> Prescribed Motion.  

• Select Cre. Change Type to SET and activate Pick.  

• Make a box around the nine nodes as in the figure.  

• Set DOF = 1 (X-translational as degree of freedom) and 

VAD = 2 (displacement as the prescribed nodal quantity, there 

are possibilities to prescribe the nodal velocity or acceleration 

as well).  

• Click on LCID and select the previously created curve.  

• Set SF = 20, which implies that the node set will be moved 20 mm.  

• Click Apply, then Done.  

  

2.6 Set the termination time  

To set the termination time:  

• Click Model > Keywrd.   

• Double-click CONTROL > TERMINATION.   

• Set ENDTIM to 0.01. The simulation will then last for 0.01 seconds.   
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• Click Accept and then Done.  

2.7 Output  

Here the output to be saved by LS-DYNA during the simulation is defined, first specify d3plot 

output:  

• Create d3plots.  

• Click Model > Keywrd.   

• Double-click DATABASE > BINARY_D3PLOT.   

• Set DT = 5e-4.   

• Click Accept and then Done.  

 

Since the task was to compare the stress vs. strain curve for an element with the material 

curve, we want to obtain this data frequently. In the first tutorial (1–Getting Started) we used 

the History command to plot information. The time-history graphs created by History, use 

information found in the d3plot files. To obtain data more frequently we can specify which type 

of data are of interest and how often it will be printed for selected elements. Therefore:  

 

• Click Model > Keywrd.  

• Double-click DATABASE > ASCII_option. We are interested in the stress and strains 

in the elements, therefore activate ELOUT. On the same row, set DT = 5e-6.  

• Click Accept, then Done.  

 

The element/elements that we want to gather data from must be defined:   

• Double-click DATABASE > 

HISTORY_SHELL in the 

Keyword Manager.   

• Write, for example, shell element number 314 under ID1, which is an element close to 

the center of the specimen.   

• Click Insert, Accept, then Done.   

• Check the model to see that everything looks okay.  

 

2.8 Save  

The model is now ready to be saved. File > Save As > Save Keyword As. Choose a folder 

path and name your file tensile_test_model.k for example. Note that the folder path cannot 

contain any spaces. Close LS-PrePost. 
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2.9 Run the simulation  

Run the simulation you will get information by the instructor.  

 

2.10 Post processing  

Open the d3plot in LS-PrePost from LS-Run or from the File menu of LS-PrePost. Start to 

press the Forward button in Animate toolbar to see what happens with the specimen. Now 

plot the stress-strain-curve from the elout file, first plot and save stress vs. time:  

• Click Post > ASCII.   

• Select elout* and click Load.  

• Select Sh-314, Ip-1 or Ip-2 (doesn’t matter which integration point in this case) and 

9Effective Stress (v-m).  

• Click Plot.  

• In the PlotWindow, click Save.   

• Let the Output Type be Curve file.  

• Enter Stress as the Filename (also set correct folder path).   

• Click Save (located at the bottom toolbar, see red square).  

• Click Quit  

   
Now plot and save the effective plastic strain vs. time:  

• Select 7-Yield Value (eps) instead of Effective Stress (v-m).  

• Click Plot.  

• Save the curve in the same way as for the stress, but name the curve Strain.  
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• Close PlotWindow and ASCII  

 

Now combine the above two curves (Stress and Strain) to plot the stress vs. strain:  

• Click Post > XYPlot.  

• Activate Cross.  

• Note that X-Axis is activated, select Strain in the top box and it will 

popup under Curve Names.  

• Click on Strain:1:Sh-314….. and it will be inserted in X:.  

When you do this, Y-Axis will be activated.  

• Select Stress in the top box and click on Stress:1:Sh-314… under 

Curve Names  and it will be inserted in Y:.  

• Click Plot.  

 

 

 

 

 

 

The curve shows effective plastic strain vs. effective stress (von Mises). The yield limit is about 

250 MPa as was stated in the material model.  

 

  

Let’s check that the tangent modulus ETAN (1000 MPa) are correct as well. Click on two 

points on the curve and calculate the tangent. Using 2 points in the figure gives:  

377 𝑀𝑃𝑎 − 265 𝑀𝑃𝑎 

 = 999 𝑀𝑃𝑎  
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0.127 − 0.0149 

2.11 Work to be done 

1) For practice change the boundary conditions so that it is fixed on the right side and loaded 

on the left side. 

 

2) 3D Thermal stress problem. This problem addresses the unconstrained expansion of 

a block due to heating. The model consists of one 8 node brick element at an initial 

temperature of 10°C. The brick material is given a volumetric thermal generation rate. It 

holds: 

 
 

The problem should be specified as a coupled thermal structural analysis in the 

(*CONTROL_SOLUTION) section. 

LS-DYNA uses a tangent coefficient of thermal expansion, which is defined as the slope of 

the thermal strain versus temperature curve for the material. 

The mechanical mass scaled time step is set to 0.01 seconds (*CONTROL_TIMESTEP) and 

the thermal time step is set to 0.1 seconds (*CONTROL_THERMAL_TIMESTEP). Explicit time 

integration is used for the structural calculations and implicit time integration is used for the 

thermal calculations. Implicit time integration is unconditionally stable and, therefore, a larger 

thermal time step can be taken.  
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Task: You will be given the LS-DYNA input file and the results. Your task is to 

understand the building of the model and the usage of the keywords. 

The following keywords are needed for the simulation: 

 

*CONTROL_SOLUTION 

$#    soln       nlq     isnan     lcint      

         2         0         0       100 

 

The Keyword *CONTROL_SOLUTION is used to specify the analysis solution procedure 

when there is thermal, coupled thermal or structural analysis is performed. 

 

Variables: 

Soln: Analysis solution procedure: 

0: Structural analysis only, 

1: Thermal analysis only, 

2: Coupled structural thermal analysis. 

 

*CONTROL_TERMINATION 

$#  endtim    endcyc     dtmin    endeng    endmas     nosol      

       1.2         0       0.0       0.01.000000E8         0 

The Keyword *CONTROL_TERMINATION is used to set the termination conditions. 

 

Variables: 

endtim: It defines the termination time of the analysis. It is a mandatory variable for the LS-

DYNA software. 

endcyc: It defines the maximum number of steps that will be analyzed, according to the step 

time (dtstart) that we will set for out problem’s analysis. Always variable endtim is more 

important and analysis will be terminated if we reach endtim value.  

dtmin:  It defines the minimum time between steps that is allowed. When the time step drops 

to dtmin, LS-DYNA terminates. By default, is inactive. 

endeng: This variable sets the maximum total energy change ratio that is allowable. If 

succeeded analysis is terminated. By default, is inactive. 

endmas: This variable sets the maximum total mass change ratio that is allowable. If 

succeeded analysis is terminated. By default, is inactive. 

 

*CONTROL_THERMAL_SOLVER 

$#   atype     ptype    solver     cgtol       gpt    eqheat     fwork       sbc 

         1         2         31.00000E-6         1       1.0       1.0       0.0 

$#  msglvl    maxitr    abstol    reltol     omega    unused    unused       tsf 

         0       5001.0000E-101.00000E-4       1.0                           1.0 
 

The keyword *CONTROL_THERMAL_SOLVER sets options for the thermal solution in a thermal 

only or coupled structural-thermal analysis. To use it is required the usage of the proper solver 

(variable soln) in *CONTROL_SOLUTION keyword. 

 

*CONTROL_THERMAL_TIMESTEP 
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$#      ts       tip       its      tmin      tmax     dtemp      tscp      lcts 

         0       0.5     0.0011.00000E-7    0.0139     100.0       0.5         0 

The keyword *CONTROL_THERMAL_TIMESTEP sets timestep for a thermal only or coupled 

structural-thermal analysis.  To use it is required the usage of the proper solver (variable soln) 

in *CONTROL_SOLUTION keyword and the *CONTROL_THERMAL_SOLVER keyword. 
 

*CONTROL_TIMESTEP 

$#  dtinit    tssfac      isdo    tslimt     dt2ms      lctm     erode     ms1st 

       0.0       0.6         0       0.0       0.0         0         0         0 

$#  dt2msf   dt2mslc     imscl    unused    unused     rmscl      

       0.0         0         0                           0.0 

The keyword  *CONTROL_TIMESTEP sets the timestep for structural problem analysis. 

 

dtini: This variable defines the initial timestep size. By default, is blank or 0 and LS-DYNA 

determines initial step size. 

 

*DATABASE_BINARY_D3PLOT 

$#      dt      lcdt      beam     npltc    psetid       

       0.0         0         0       100         0 

$#   ioopt      

         0 

The keyword *DATABASE_BINARY_D3PLOT defines parameters for the output from entire 

of the model. From these outputs by post processing them we will conclude to an final 

presentable output of our solution analysis. 

 

dt:  In this variable we set the time interval between output states. 

nr:  In this variable we set Number of RUNning ReStart Files, RUNRSF, written in a cyclical 

fashion. The default is 1, i.e., only one runrsf file is created and the data there in is overwritten 

each time data is output. 

npltc: In this variable we calculate DT = ENDTIME/NPLTC applies to D3PLOT and D3PART 

only. This overrides the DT specified in the first field.  

 

*DATABASE_GLSTAT 

$#      dt    binary      lcur     ioopt      

     0.003         0         0         1 

 

The keyword *DATABASE has many options to define to obtain output files containing results 

information. One of them is the *DATABASE_GLSTAT, which provide us with the global data 

of the solution analysis of our model. 

 

Dt :  In this variable we se the time step between outputs. If is set to 0 then no output is 

printed.  

binary  :  In this variable we set the type for binary output. 

 1 : Data written to an ASCII file default for SMP LS-DYNA. 

 2 : Data written to binary database “binout”, default for MPP LS-DYNA. 

 3 : Both ASCII and binary outputs. 
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*PART 

$#                                                                         title 

                                                                                 

$#     pid     secid       mid     eosid      hgid      grav    adpopt      tmid 

            2           1           1            1           0           0             0          1 

 

The keyword *PART is essential for the model identification and characterization in the 

solution analysis. Within it variables we combine various properties and messes to form the 

parts we want to analyze. To form a part in LS-DYNA we combine the identity of a formed 

mess with the identity of the material, with the identity of the used Equation Of State for that 

material, with the thermal properties identity, etc. 

 

pid: In this variable we put the part id number 

secid: In this variable we put the section id number, defined in a *SECTION keyword. 

mid: In this variable we put the material id number, defined in a *MAT keyword. 

eosid: In this variable we put the Equation Of State id number, defined in a *EOS keyword. 

tmid: In this variable we put the thermal properties id number, defined in a *MAT_THERMAL 

keyword. 

 

*SECTION_SOLID 

$#   secid    elform       aet    

             1            1           0 

In this keyword, we define section properties for solid continuum and fluid elements. 

 

secid: In this variable we put the section id number, defined in a *SECTION keyword. 

elform: Element formulation options: 

-2: Fully integrated S/R solid intended for elements with poor aspect ratio, accurate 

formulation  

-1: Fully integrated S/R solid intended for elements with poor aspect ratio, efficient 

formulation 

  0: 1 point corotational for *MAT_MODIFIED_HONEYCOMB  

    1: Constant stress solid element: default element type.  

    2: Fully integrated S/R solid 

    3: Fully integrated quadratic 8 node element with nodal rotations 

    4: S/R quadratic tetrahedron element with nodal rotations 

    5: 1 point ALE 

    6: 1 point Eulerian 

    7: 1 point Eulerian ambient 

    8: Acoustic 

    9: 1 point corotational for *MAT_MODIFIED_HONEYCOMB 

    10: 1 point tetrahedron 

    11: 1 point ALE multi-material element 

and various others. 
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*MAT_ELASTIC_PLASTIC_THERMAL 

Task: Determine the usage of this material keyword. 

*MAT_THERMAL_ISOTROPIC 
$#    tmid       tro     tgrlc    tgmult      tlat      hlat     
         1          0.0       0.0       0.0       0.0       0.0 
$#      hc        tc   
     560.03.70000E-5 
 
This keyword *MAT_THERMAL_ISOTROPIC  defines thermal isotropic properties to the 
material that selects it. 
 
tmid:  In this variable we set the unique ID number of the thermal material identification. 
tro:  In this variable we set the thermal density of the material. If set to 0.0 then it is equal to 
the structural density. 
hc:  In this variable we set the specific heat of the material 
tc:  In this variable we se the thermal conductivity of the material. 
 

 

*ELEMENT_SOLID 
$#   eid     pid      n1      n2      n3      n4      n5      n6      n7      n8 
       1       1    4313    4309    5283    5313    4308    4308    5138    5138 
       2       1    5313    5283    5284    5314    5138    5138    5139    5139 
       3       1    5314    5284    5285    5315    5139    5139    5140    5140 
 
 
In this keyword *ELEMENT_SOLID we define each element of the created mess of our model 
that we are going to perform solution analysis. Elements are defined in three-dimensional solid 
elements including 4 noded tetrahedrons and 8-noded hexahedrons. Most common are the 8-
noded hexahedrons.  
 
eid:  In this variable we set the unique ID number of the element. 
pid:  In this variable we set part ID number from with this element comes from. 
n1 – n8:  In these variables we set the nodal points ID that consists the element. If we use 
tetrahedron shape for our elements then we set only n1 – n4 nodal point variables. 
 
 
*NODE 
$#   nid                   x                     y                    z      tc      rc   
       1        -0.027596        0.019934          0.2715       0       0 
       2       0.0576701                  1.0          0.2715       0       0 
       3        -0.027596        0.019934          0.1285       0       0 
 
 
In the keyword  *NODE  we define the nodes of our model. We also can define boundary 
conditions for that nodes. Nodes are defined by setting their coordinates at X-Y-Z axis. 
 
nid:  In this variable we set the unique node ID number 
x:  In this variable we set the X coordinate of the node 
y:  In this variable we set the Y coordinate of the node 
z:  In this variable we set the Z coordinate of the node 
tc:  In this variable we set the translational constraint: 
 0: no constraints, 

1: constrained x displacement, 
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2: constrained y displacement, 
3: constrained z displacement, 
4: constrained x and y displacements, 
5: constrained y and z displacements, 
6: constrained z and x displacements, 
7: constrained x, y, and z displacements. 

rc:  In this variable we set the rotational constraint: 
 0: no constraints, 

1: constrained x rotation, 
2: constrained y rotation, 
3: constrained z rotation, 
4: constrained x and y rotations, 
5: constrained y and z rotations, 
6: constrained z and x rotations, 
7: constrained x, y, and z rotations. 

 

*INITIAL_TEMPERATURE_NODE 

It defines the initial temperature for the selected nodes. 

 

References 
Tutorials taken from: https://www.dynasupport.com/tutorial/introduction-ls-dyna-ls-

prepost-for-explicit-and-implicit-analysis 

https://www.dynasupport.com/manuals 
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1. Laser heating of a metal 

1.1 Problem Description  

The heating of a AISI H13 steel workpiece is examined during irradiation by a CW continuous 

laser. 3D transient coupled thermal-structural numerical simulations take place using LS-

DYNA.  

The workpiece is defined as a deformable body. The laser beam is modeled as a Gaussian 

moving heat source. For the dynamic elastoplastic behavior of the workpiece: a Johnson-Cook 

constitutive strength material model will be used. 

2 Governing equations  

2.1 3D transient heat conduction equation  

 

𝜌𝑐 (
𝜕𝑇

𝜕𝑡
+ 𝑉𝑥

𝜕𝑇

𝜕𝑥
) =

𝜕

𝜕𝑖
(𝜅(𝛵)

𝜕𝛵

𝜕𝑖
) + 𝑄̇ − 𝑎𝑇𝑇0(3𝜆 + 2𝜇)𝜀𝑖̇𝑖 

 

 

 

(1) 

 
i=x,y,z coordinates, t time 

ρ the density, c the specific heat, V
x
 the laser scanning speed along the x-direction 

k thermal conductivity and 𝑄̇ the power generation per unit volume 

T temperature, T
0
 ambient temperature, α

Τ
 thermal expansion coefficient,  

λ, μ lame coefficients, 𝜀𝑖̇𝑖 strain rate 

 
2.2 3D transient mechanical equation  
 

𝜌
𝜕2𝑈𝑖

𝜕2𝑡
= 𝜇

𝜕2𝑈𝑖

𝜕2𝑘
+ (𝜆 + 𝜇)

𝜕

𝜕𝑖
(

𝜕𝑈𝑘

𝜕𝑘
) − (3𝜆 + 2𝜇)𝛼𝛵

𝜕𝛵

𝜕𝑖
 

 

 
(2) 

 
U the displacement, ρ the density, λ and μ lame coefficients, α

Τ
 thermal expansion coefficient 

The strain tensor 

𝜀𝑖𝑗 =
1

2
(

𝜕𝑈𝑖

𝜕𝑈𝑗
+

𝜕𝑈𝑗

𝜕𝑈𝑖
) 

 

(3) 

The stress tensor 

𝜎𝑖𝑗 = 2𝜇𝜀𝑖𝑗 + 𝜆𝜀𝑘𝑘𝛿𝑖𝑗 − (3𝜆 + 2𝜇)𝑎𝑇  (𝛵 − 𝛵0)𝛿𝑖𝑗 (4) 
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2.3 Modeling of laser heat source 
The Gaussian distribution of the q(r) absorbed laser heat flux or laser power intensity is given  

by: 

𝑞(𝑥, 𝑧) =
2𝑃𝑡𝑜𝑡

𝜋𝑟𝑏
2 𝑒

−(
2((𝑥−𝑡𝑉𝑥)2+𝑧2)

𝑟𝑏
2 )

 

 

(5) 

where Ptot is the total absorbed power and rb is the laser beam radius. It also holds that: 

 

𝑃𝑡𝑜𝑡 = 𝜂𝑃𝑖𝑛𝑐 

 

(6) 

where Pinc is the incident laser power, η is the average absorptivity of the workpiece material 

and t is the time. 

The laser heat flux is applied to the top surface of the workpiece. The boundary condition on 

the top laser irradiated surface takes into account the heat flux, convection and radiation and 

it holds: 

−𝑘
𝜕𝑇

𝜕𝑦
= 𝑞(𝑥, 𝑧) − ℎ(𝑇 − 𝑇0) − 𝜎𝜀(𝛵4 − 𝛵0

4) 

 

 

(7) 

where h is the convective heat transfer coefficient, T0 is the ambient temperature, σ is the 

Stefan–Boltzmann constant (5.67 108W/m2K4) and ε is emmisivity. Heat flux is considered to 

be normal to the laser irradiated surface, while the motion of the laser beam is considered 

along the X-direction. 

Moreover, the laser beam diameter is considered to be 250 μm, the laser power is 98.2 W 

and the heat flux is 2 kW/mm2. 
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3 Finite Element Modeling  
The workpiece dimensions are 3.0 x 0.4 x 0.5 mm. The workpiece is modeled with 

approximately 115,000 solid elements. The mesh of the workpiece is shown in Figure 1.  

 

Figure 1.1 Mesh and geometry of the workpiece 

 

Regarding the initial and boundary conditions, all translations and rotations of the bottom and 

the left side of the workpiece are fully constrained and Z translations at its front and back side 

are also constrained. The ambient temperature is assumed to be 20 0C. 

 

3.1 Material model 
The adoption of a suitable material-constitutive model for the workpiece is critical. Τhe 

selected material model is the Johnson-Cook (J-C), a purely empirical one that takes into 

account the effect of plastic strain, strain rate and temperature. The flow stress is expressed 

as: 

𝜎𝑦 = (𝐴 + 𝐵𝜀𝑛)(1 + 𝐶𝑙𝑛
𝜀̇

𝜀0̇
)(1 −

𝛵 − 𝛵𝑟

𝛵𝑚 − 𝛵𝑟
)𝑚 

 

 

(8) 

where ε is the equivalent plastic strain, 𝜀̇/𝜀0̇ is the dimensionless plastic strain rate, 𝜀0̇=1s-1 is 

a reference strain rate used to normalize the strain rate, A is the yield stress, B is the hardening 

constant, C is the strain rate sensitivity, n is the hardening exponent, m is the thermal softening 

exponent, Tm is the melting temperature of the workpiece and Tr the room temperature. The 

material constants A, B, C, n, m are determined from experimental results. 

 
 
 
 



 
 

P a g e  | 213 
 

 

3.2 Material properties 
The physical properties of the AISI H-13 steel workpiece are listed in Table 1 for room 

temperature. The J-C material model and failure parameters of the workpiece are listed in 

Table 2.  

Property Workpiece 

Density [kg/m3] 7800 

Elastic modulus [GPa] 211 

Poisson’s ratio [-] 0.28 

Specific heat [J/kg K] 560 

Thermal conductivity [W/m K] 37 

Thermal expansion [10-6C] 10.4 

Melting Point [K] 1700 

Table 1.1 Mechanical and physical properties of AISI H-13 in room temperature 

Material model 
Parameters 

A [MPa] B [MPa] n [-] C [-] m [-] 

Values 674.8 239.2 0.28 0.027 1.3 

Table 1.2 Johnson-Cook material model and failure parameters of AISI H-13 

Furthermore, a mean value of absorptivity η=0.5 and a mean value of emmisivity ε=0.4 are 

considered based on the work of Singh et al. For the convectional heat transfer to the 

surrounding air, a heat transfer coefficient of h=5 W/m2K is also considered. The laser 

scanning speed is considered to be 150 m/min. 

 

 

4 Work to be done 
1) Read the keywords of the code so you can understand what each of them does. 

2) From the code that you will be given identify first which consistent units you use. 

3) Create a mesh that will have dimensions 3 x 0.4 x 0.5 mm along the x,y,z directions and 

the discretization will be 225 x 30 x 30 respectively resulting in a total number of 202500 

elements using the Shapemesher command.  
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Figure 1.2 Shapemesher 

 

4) Constrain all the translations and rotations at the bottom and the left side of the workpiece. 

Moreover constrain the Z translations at its front and back side. For this purpose you will 

need to use the keywords *BOUNDARY_SPC_SET, *SET_NODE_LIST. 

5) Define the surface where the laser heat flux is applied. This will be on the top of the 

workpiece. Use the *SET_SEGMENT command. 

6) Then your work will be examined by the instructor and he will further help you to complete 

the simulation. 
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The following keywords needed for the simulation are explained: 

*CONTROL_SOLUTION 

$#    soln       nlq     isnan     lcint      

         2         0         0       100 

The Keyword *CONTROL_SOLUTION is used to specify the analysis solution procedure 

when there is thermal, coupled thermal or structural analysis is performed. 

 

Variables: 

Soln: Analysis solution procedure: 

0: Structural analysis only, 

1: Thermal analysis only, 

2: Coupled structural thermal analysis. 

 

*CONTROL_TERMINATION 

$#  endtim    endcyc     dtmin    endeng    endmas     nosol      

       1.2         0       0.0       0.01.000000E8         0 

The Keyword *CONTROL_TERMINATION is used to set the termination conditions. 

 

Variables: 

endtim: It defines the termination time of the analysis. It is a mandatory variable for the LS-

DYNA software. 

endcyc: It defines the maximum number of steps that will be analyzed, according to the step 

time (dtstart) that we will set for out problem’s analysis. Always variable endtim is more 

important and analysis will be terminated if we reach endtim value.  

dtmin:  It defines the minimum time between steps that is allowed. When the time step drops 

to dtmin, LS-DYNA terminates. By default, is inactive. 

endeng: This variable sets the maximum total energy change ratio that is allowable. If 

succeeded analysis is terminated. By default, is inactive. 

endmas: This variable sets the maximum total mass change ratio that is allowable. If 

succeeded analysis is terminated. By default, is inactive. 

 

*CONTROL_THERMAL_SOLVER 

$#   atype     ptype    solver     cgtol       gpt    eqheat     

fwork       sbc 

         1         2         31.00000E-6         1       1.0       

1.0       0.0 

$#  msglvl    maxitr    abstol    reltol     omega    unused    

unused       tsf 

         0       5001.0000E-101.00000E-4       1.0   

 

The keyword *CONTROL_THERMAL_SOLVER sets options for the thermal solution in a 

thermal only or coupled structural-thermal analysis. To use it is required the usage of the 

proper solver (variable soln) in *CONTROL_SOLUTION keyword. 
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*CONTROL_THERMAL_TIMESTEP 

$#      ts       tip       its      tmin      tmax     dtemp      

tscp      lcts 

         0       0.5     0.0011.00000E-7    0.0139     100.0       

0.5         0 

 

The keyword *CONTROL_THERMAL_TIMESTEP sets timestep for a thermal only or coupled 

structural-thermal analysis.  To use it is required the usage of the proper solver (variable soln) 

in *CONTROL_SOLUTION keyword and the *CONTROL_THERMAL_SOLVER keyword. 
 

 

*CONTROL_TIMESTEP 

$#  dtinit    tssfac      isdo    tslimt     dt2ms      lctm     

erode     ms1st 

       0.0       0.6         0       0.0       0.0         0         

0         0 

$#  dt2msf   dt2mslc     imscl    unused    unused     rmscl      

       0.0         0         0                           0.0 

 

The keyword  *CONTROL_TIMESTEP sets the timestep for structural problem analysis. 

 

dtini: This variable defines the initial timestep size. By default, is blank or 0 and LS-DYNA 

determines initial step size. 

 

*CONTROL_THERMAL_NONLINEAR 

$#  refmax       tol       dcp    lumpbc    thlstl    nlthpr    

phchpn       

       100       0.0       1.0         0       0.0         0       

0.0 

 

The keyword *CONTROL_THERMAL_NONLINEAR set parameters for a nonlinear thermal or 

coupled structural-thermal analysis. The control card, *CONTROL_SOLUTION, (variable soln) 

is also required. 

 

*DATABASE_BINARY_D3PLOT 

$#      dt      lcdt      beam     npltc    psetid       

        0.0          0             0       100           0 

$#   ioopt      

             0 

The keyword *DATABASE_BINARY_D3PLOT defines parameters for the output from entire 

of the model. From these outputs by post processing them we will conclude to an final 

presentable output of our solution analysis. 

 

dt:  In this variable we set the time interval between output states. 

nr:  In this variable we set Number of RUNning ReStart Files, RUNRSF, written in a cyclical 

fashion. The default is 1, i.e., only one runrsf file is created and the data there in is overwritten 

each time data is output. 
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npltc: In this variable we calculate DT = ENDTIME/NPLTC applies to D3PLOT and D3PART 

only. This overrides the DT specified in the first field.  

 

*DATABASE_GLSTAT 

$#      dt    binary      lcur     ioopt      

     0.003         0         0         1 

 

The keyword *DATABASE has many options to define to obtain output files containing results 

information. One of them is the *DATABASE_GLSTAT, which provide us with the global data 

of the solution analysis of our model. 

 

Dt:  In this variable we se the time step between outputs. If is set to 0 then no output is 

printed.  

binary:  In this variable we set the type for binary output. 

 1: Data written to an ASCII file default for SMP LS-DYNA. 

 2: Data written to binary database “binout”, default for MPP LS-DYNA. 

 3: Both ASCII and binary outputs. 

 

 

*MAT_ADD_THERMAL_EXPANSION 

$#     pid      lcid      mult      lcid     multy      lcid     multz      

            2        69       1.0         0        1.0           0        1.0 

 

With this keyword *MAT_ADD_THERMAL_EXPANSION we add thermal expansion 

properties to all nonlinear solid, shell, thick shell and beam elements and all material models.  

 

pid: In this variable we put the PART ID of the part that we add thermal expantion 

lcid: For isotropic material models, LCIDY, MULTY, LCIDZ, and MULTZ are ignored, and 

LCID is the load curve ID defining the thermal expansion coefficient as a function of 

emperature. If zero, the thermal expansion coefficient is constant and equal to MULT.  

mult: Scale factor scaling load curve given by LCID. 

 

*PART 

$#                                                                         title 

                                                                                 

$#     pid     secid       mid     eosid      hgid      grav    adpopt      tmid 

            2           1           1            1           0           0             0          1 

 

The keyword *PART is essential for the model identification and characterization in the 

solution analysis. Within it variables we combine various properties and messes to form the 

parts we want to analyze. To form a part in LS-DYNA we combine the identity of a formed 

mess with the identity of the material, with the identity of the used Equation Of State for that 

material, with the thermal properties identity, etc. 

 

pid: In this variable we put the part id number 
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secid: In this variable we put the section id number, defined in a *SECTION keyword. 

mid: In this variable we put the material id number, defined in a *MAT keyword. 

eosid: In this variable we put the Equation Of State id number, defined in a *EOS keyword. 

tmid: In this variable we put the thermal properties id number, defined in a *MAT_THERMAL 

keyword. 

 

*SECTION_SOLID 

$#   secid    elform       aet    

              1           1           0 

In this keyword, we define section properties for solid continuum and fluid elements. 

 

secid: In this variable we put the section id number, defined in a *SECTION keyword. 

elform: Element formulation options: 

-2: Fully integrated S/R solid intended for elements with poor aspect ratio, accurate formulation  

-1: Fully integrated S/R solid intended for elements with poor aspect ratio, efficient formulation 

  0: 1 point corotational for *MAT_MODIFIED_HONEYCOMB  

    1: Constant stress solid element: default element type.  

    2: Fully integrated S/R solid 

    3: Fully integrated quadratic 8 node element with nodal rotations 

    4: S/R quadratic tetrahedron element with nodal rotations 

    5: 1 point ALE 

    6: 1 point Eulerian 

    7: 1 point Eulerian ambient 

    8: Acoustic 

    9: 1 point corotational for *MAT_MODIFIED_HONEYCOMB 

    10: 1 point tetrahedron 

    11: 1 point ALE multi-material element 

    and various others 

 

*MAT_JOHNSON_COOK_TITLE 

*MAT_JOHNSON_COOK_TITLE 

blank 

$#     mid        ro         g         e        pr       dtf        

vp    rateop 

         17.80000E-6      81.0     211.0      0.281.80000E-7       

0.0       0.0 

$#       a         b         n         c         m        tm        

tr      epso 

     0.675     0.239      0.28     0.027       1.3    1427.0      

20.0     0.001 

$#      cp        pc     spall        it        d1        d2        

d3        d4 

     560.0       0.0       2.0       0.0      -0.8       2.1      -

0.52.00000E-4 

$#      d5      c2/p      erod     efmin    numint       

       2.7       0.0         01.00000E-6       0.0 

 



 
 

P a g e  | 219 
 

Johnson-Cook is an empirical model for the flow stress and strain rate. It is the most common 

used Viscoplasticity and yield stress model. 

 

So in this keyword (*MAT_JOHNSON_COOK_TITLE) we set the variables of the Johnson-

Cook model for a material. 

 

mid:  In this variable we put the material identification number. 

ro:  In this variable we set the mass density of the material 

g:  In this variable we set the shear modulus of the material. 

e:  In this variable we set the Young’s modulus of the material 

pr:  In this variable we set the Poisson’s ratio of the materia 

dtf:  In this variable we set the Minimum time step size for automatic element deletion (shell 

elements). 

 

vp:  In this variable we set the formulation for rate effects: 

0.0  for scale yield stress 

1.0  for Viscoplastic formulation 

 

a,b,n,c,m: These variables are the input constants of the Johnson-Cook formula 

tm:  In this variable we set the melt temperature of the material 

tr:  In this variable we set the room temperature 

cp:  In this variable we set the specific heat  

pc: In this variable we set the tensile failure stress or tensile pressure cutoff (PC < 0.0) 

 

*EOS_LINEAR_POLYNOMIAL 
*EOS_LINEAR_POLYNOMIAL 

$#   eosid        c0        c1        c2        c3        c4        

c5        c6 

         1       0.0     160.0       0.0       0.0       0.0       

0.0       0.0 

$#      e0        v0   

       0.0       1.0 

 

This is the keyword *EOS_LINEAR_POLYNOMIAL where we define coefficients for a linear 
polynomial Equation Of State and initialize the thermodynamic state of the material. 
 
 
 
 
eosid: In this variable we set the unique number ID of the EOS 
c0: In this variable we set the 0th polynomial equation coefficient. 
c1:  In this variable we set the 1st polynomial equation coefficient (when used by itself, this 
is the elastic bulk modulus) 
 
*MAT_THERMAL_ISOTROPIC 
$#    tmid       tro     tgrlc    tgmult      tlat      hlat     

         1       0.0       0.0       0.0       0.0       0.0 

$#      hc        tc   

     560.03.70000E-5 
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This keyword *MAT_THERMAL_ISOTROPIC defines thermal isotropic properties to the 
material that selects it. 
 
tmid:  In this variable we set the unique ID number of the thermal material identification. 
tro:  In this variable we set the thermal density of the material. If set to 0.0 then it is equal to 
the structural density. 
hc:  In this variable we set the specific heat of the material 
tc:  In this variable we se the thermal conductivity of the material. 
 

*ELEMENT_SOLID 
$#   eid     pid       n1       n2        n3        n4        n5        n6        n7        n8 
          1       1   4313    4309    5283    5313    4308    4308    5138    5138 
          2       1   5313    5283    5284    5314    5138    5138    5139    5139 
          3       1   5314    5284    5285    5315    5139    5139    5140    5140 
 
 
In this keyword *ELEMENT_SOLID we define each element of the created mess of our model 
that we are going to perform solution analysis. Elements are defined in three-dimensional solid 
elements including 4 noded tetrahedrons and 8-noded hexahedrons. Most common are the 8-
noded hexahedrons.  
 
eid:  In this variable we set the unique ID number of the element. 
pid:  In this variable we set part ID number from with this element comes from. 
n1 – n8:  In these variables we set the nodal points ID that consists the element. If we use 
tetrahedron shape for our elements then we set only n1 – n4 nodal point variables. 
 
 
*NODE 
$#   nid                  x                      y                   z      tc      rc   
       1       -0.027596        0.019934          0.2715       0       0 
       2       0.0576701                 1.0          0.2715       0       0 
       3       -0.027596        0.019934          0.1285       0       0 
 
 
In the keyword *NODE  we define the nodes of our model. We also can define boundary 
conditions for that nodes. Nodes are defined by setting their coordinates at X-Y-Z axis. 
 
nid:  In this variable we set the unique node ID number 
x:  In this variable we set the X coordinate of the node 
y:  In this variable we set the Y coordinate of the node 
z:  In this variable we set the Z coordinate of the node 
tc:  In this variable we set the translational constraint: 
 
 0: no constraints, 
1: constrained x displacement, 
2: constrained y displacement, 
3: constrained z displacement, 
4: constrained x and y displacements, 
5: constrained y and z displacements, 
6: constrained z and x displacements, 
7: constrained x, y, and z displacements. 
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rc:  In this variable we set the rotational constraint: 
 
 0: no constraints, 
1: constrained x rotation, 
2: constrained y rotation, 
3: constrained z rotation, 
4: constrained x and y rotations, 
5: constrained y and z rotations, 
6: constrained z and x rotations, 
7: constrained x, y, and z rotations. 
 

 

*DEFINE_FUNCTION 
$#     fid                                                               heading 

         3                                                                       

$#                                                                      function 

f(x,z,time,temp)=-(2)/(exp(128*((x-2.5*time)*(x-2.5*time)+(z-0.2)*(z-0.2))))+(5* 

10**(-8))*(temp-20)+(5.7*10**(-17))*0.5*((temp**4)-160000) 

 

In this keyword *DEFINE_FUNCTION we define a function that we can used by other 

keywords.  

 

fid:  In this variable we set the function ID number 

heading:  In this variable we set an optional descriptive heading. 

function: In this variable we set the arithmetic expression that represents our function.  

 

*BOUNDARY_FLUX_SET 
$#    ssid     

         1 

$#    lcid      mlc1      mlc2      mlc3      mlc4       loc     nhisv       fid 

         3       1.0       1.0       1.0       1.0         0         0         3 

 

The keyword  *BOUNDARY_FLUX  is to apply a flux boundary condition.  

 

ssid: In this variable we set the set ID number 

lcid : In this variable we set the ID of a reference load curve 

mlc1-mlc4: In this variables we set the curve multipliers.  

fid: in this variable we set the ID number of the function we use 

 

*SET_SEGMENT 
$#     sid       da1       da2       da3       da4    solver       

         1       0.0       0.0       0.0       0.0MECH 

$#      n1        n2        n3        n4        a1        a2        a3        a4 

    129285    129645    129647    129287       0.0       0.0       0.0       0.0 

    123165    123525    123527    123167       0.0       0.0       0.0       0.0 

    117045    117405    117407    117047       0.0       0.0       0.0       0.0 

 

In this keyword *SET_SEGMENT we define set of segments with optional identical or unique 

attributes. 
 

sid: In this variable we set the unique set ID number. 
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solver: In this variable we set the name of the solver of the set. 

n1–n4: In this variable we set the nodal points  
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5.1 Simulating Particles In Cells 

The particle-in-cell (PIC) method is used to solve a certain class of partial deferential equations 

(PDEs) in order to model physical systems behavior. Often used is a plasma physics simulation. 

In this method, collections of physical particles are represented using a smaller number of 

macroparticles. The E, B fields generated by the motion of these macroparticles are calculated 

using a Finite Differences technique on an underlying grid of fixed spatial resolution. The 

forces on the macroparticles due to the calculated fields are then used to update the 

macroparticle velocities, and these velocities are then used to update their positions.  

In PIC method, the individual particles (or fluid elements) are tracked in a continuous phase 

space, whereas moments of the distribution such as densities and currents are computed 

concurrently on stationary mesh points 

Scope of this presentation is to introduce and familiarize the participants with the opensource 

advance relativistic EM MPI parallelized code EPOCH, developed under the Extendable PIC 

Open Collaboration project in UK. Likewise, perform of numerical simulations of an intense, 

fs laser pulse interacting with solid density plasma.  

EPOCH initially calculates the electric and magnetic field values on the grid, by solving the 

Maxwell equations. At the next step the velocity of the particles is calculated and their new 

position on the grid is updated. Finally, the current density from the particle flux, through the 

grid is calculated, which in turn affects the electric and magnetic fields on the grid. After a full 

iteration these steps are repeated, as it is schematically depicted in the flowchart of figure 1.  
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Calculating/Updating E,B
on the grid via Maxwell 
equations.

calculating via F 
Lorentz equation. 
Updating  ofx,u
the particles

calulating  from J,p
particle flux though
the grid

Δt

 

Figure 0-1: The particle-in-cell scheme. The steps of one full iteration. 

EPOCH follows the Kinetic description of plasma that is based on a set of equations for 

(macroscopic) distribution function 𝑓𝑠(𝑥, 𝑝) of each plasma particle species together with 

Maxwell equations. The distribution function is a statistical description of a very large number 

of interacting particles. Each particle has its own position in the phase space (𝑥, 𝑝), where x, 

y, z are the coordinates for all the degrees of freedom and 𝑝𝑥, 𝑝𝑦, 𝑝𝑧 are the corresponding 

momentum components. 

EPOCH solves the following set of equations (Normalized Vlasov-Maxwell equations): 

• 
𝜕

𝜕𝑡
𝐸(𝑥, 𝑡) = 𝛻 × 𝐵(𝑥, 𝑡) − 𝐽𝛵(𝑥, 𝑡)  (Ampere) 

• 
𝜕

𝜕𝑡
𝐵(𝑥, 𝑡) = −𝛻 × 𝐸(𝑥, 𝑡)  (Faraday)  

• 𝛻 ⋅ 𝐸(𝑥, 𝑡) = 𝜌𝛵(𝑥, 𝑡) (Poisson) 

• 𝛻 ⋅ 𝐵(𝑥, 𝑡) = 0 (Gauss) 

• 
𝜕

𝜕𝑡
𝑓𝑛(𝑥, 𝑣, 𝑡) + 𝑣𝛻𝑥𝑓𝑛(𝑥, 𝑣, 𝑡) −

𝑞𝑛

𝑚𝑛
(𝐸 + 𝑣 × 𝐵)𝛻𝑣𝑓𝑛(𝑥, 𝑣, 𝑡) = 0 (Vlasov)  

• 𝜌𝛵(𝑥, 𝑡) = ∫[∑ 𝑞𝑛𝑛 𝑓𝑛(𝑥, 𝑣, 𝑡)] 𝑑𝑣  

• 𝐽𝛵(𝑥, 𝑡) = ∫[∑ 𝑞𝑛𝑛 𝑓𝑛(𝑥, 𝑣, 𝑡)] 𝑣𝑑𝑣  

During the pre-processing of a simulation, numerous parameters and limitations must be 

taken into account. The dimensions of the simulation are chosen. EPOCH allows for 1,2 and 
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3D simulations, while the more the dimensions used, the higher the computational demands. 

Then, the simulation solution domain (box size) and the total simulation duration are set, 

based on the interaction time of interest. The spatial resolution of the simulation comes from 

the chosen grid points that divide the simulation box into cells. The cell size should meet 

certain criteria, e.g.: if the cell size exceeds the Debye length of the simulated plasma, 

nonphysical electric fields will arise on the grid, leading to rapid increase of the particle 

energy. This issue is known as numerical heating. EPOCH uses macroparticles which represent 

many real particles, acting collectively. This division of actual particles into less macroparticles 

relaxes the computational demands of a simulation, although a very low number of 

macroparticles will lead to unnatural heating of the plasma. The electron temperature should 

be also taken into consideration. For higher electron temperatures the Debye length 

increases in size and this relaxes the spatial discretization requirements in order to resolve it 

although one should be careful not to excide the actual temperatures the electrons would 

acquire from a real laser prepulse. Additionally, unnaturally high electron temperature will 

lead to unreal plasma expansion rate. If λD is resolved, the time step must be 

 
𝛥𝑡 ≤

1

𝑐√(
1

𝛥𝑥2 +
1

𝛥𝑦2)

 
 

to preserve the numerical stability. 

5.2 EPOCH for TNSA 

During the hands-on course, the participants initially installed a Virtual box machine running 

on Ubuntu 18.04 with pre-installed all the required software packages. During the lecture, 

step by step instruction were given in order to run the provided TNSA testcase on EPOCH 2D. 

Followed by visualization of the output e.g. particle density, laser electric field and particle 

momentum using the Open Source, interactive, scalable, visualization, animation and analysis tool 

VisIt. The first simulation was only the laser pulse without the target, this was done by having  

pre-set the number of sudoparticles per cell equal zero. Afterwards, it was required to modify 

the input file of the TNSA testcase in order to familiarize the participants with the setting of a 

2D testcase. The training simulations were perform using low number of particles per cell and 

a low-resolution grid in order not to be extremely time consuming and able to be performed 
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in any laptop using at least 2 parallel processors.  The required modifications of the input file 

were to change the number of grid point, set the number of particles per species per cell from 

0 to 1 and set the simulation duration to 100fs. This run was estimated to require 

approximately 30 minutes using 2 CPU cores. After the visualization of the outputs, it was 

required one more modification of the testcase, this time it was asked to change the plasma 

density, pulse duration, energy, focal spot diameter and aluminum ionization degree, based 

the participants preferences.  This was given as a homework to the participants along with an 

extra task to create on new block of partially ionized carbon.  
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5.4 Hands on TNSA with PIC 
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